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Introduction

Media Recorder is a software package that makes digital video files with input of many different types of cameras. These 
video files can be used in the video analysis programs The Observer XT, EthoVision XT and FaceReader.

video devices 

Media Recorder is supported with several types of video devices. In the section on the type of device, you find which 
specific devices are tested and supported, how many devices you can use simultaneously, at what frame rate and 
resolution and in which Noldus software.

Media Recorder is supported with the following devices types. See the section on the device type which specific video 
device has been tested. 

 Analog cameras (page 22). 

 IP cameras (page 24).

 USB cameras (page 27).

 The DanioVision FireWire system (page 29).

 GigE cameras (page 30).

 Screen capture devices (page 31).

We recommend to create a test recording with your devices first before you carry out the actual recordings, especially 
when you have more or other devices than we officially support. See also Appendix C on page 75.
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modules

Media Recorder has the following modules: 

 Base Module – To record up to four video files simultaneously. However this number depends on the type of video 
device, since multiple cameras are not supported for all devices. See the section on your device how many devices are 
supported at what frame rate and resolution.

 Additional Camera Module 1-6 camera – For analog, or IP cameras only. To extend the number of cameras to 6. 

 Additional Camera Module 1-8 cameras – For IP cameras only. To extend the number of cameras to 8.

 MR Screen Capture Module – To create a video recording of the monitor of the computer with Media Recorder.

standalone or with commands

Media Recorder can be used as a standalone program to create video files. It is also possible to send commands with The 
Observer XT to Media Recorder. This way, recording with Media Recorder starts automatically when starting an observation 
in The Observer XT and stops when ending this observation. Furthermore, the videos obtained this way can automatically 
be linked to an observation and are then automatically synchronized with the manually scored events. 

It is also possible to control recording with commands from EthoVision XT, for example to start recording when a mouse 
leaves the shelter. 

this manual

This manual describes how to use Media Recorder 4 with the supported recording devices. The procedures in this manual 
about devices from companies other than Noldus IT, describe the status at the moment this manual was written. These 
procedures may change afterwards without our knowledge. 

If you have any problems, questions, remarks or comments, please let us know. See technical support on page 72 for 
contact information. 

What’s new in Media Recorder 4

If you have been using a previous version of Media Recorder, you should read this section to get an idea of the 
improvements in this version. 

what’s new compared to version 3

Windows 7, 64 bit and Windows 10, 64 bit compatible

Media Recorder is compatible with the 64 bit versions of Windows 7 and Windows 10. For more information, see “System 
requirements for Noldus software” on www.noldus.com/downloads.

Supported devices

Media Recorder 3 was supported with IP cameras, the Microsoft LifeCam Studio, and some screen capture devices. Media 
Recorder 4 is supported with the following devices:

 Analog cameras in combination with a Euresys Picolo U4, or U8 H.264 frame grabber card. 

 IP cameras

 USB cameras

 The camera from the (old) DanioVision FireWire system
9
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 GigE cameras

 Screen capture devices

See Supported devices on page 14 for a full overview of the devices that were tested with Media Recorder 4. 

MR Screen Capture Module

You can extend your basic Media Recorder license with the MR Screen Capture Module. With this module, you can capture 
the screen or windows on the monitor of the computer with Media Recorder. 

Frame rate and resolution of IP cameras

In previous versions of Media Recorder, changing the frame rate and resolution of IP cameras was done with the tool 
Onvifprofilemanager. Changing the frame rate and resolution is now done in Media Recorder itself. 

Improved video output

The video output Picture by Picture was improved. In previous versions the videos were surrounded by black areas. These 
have been removed. 

what’s new compared to version 2.5

Additional Camera Modules

For analog, and IP cameras it is now possible to extend the number of cameras to six and for IP cameras to eight.

Pan, tilt, zoom control for IP cameras

It is now possible to pan, tilt and zoom the IP cameras with Media Recorder. So it is no longer necessary to use a web 
browser for that purpose. It is also possible to use a joystick for pan, tilt, zoom control. 

Audio from IP cameras

Media Recorder can now record audio from IP cameras, if they have their own microphone, or an audio input. It is no longer 
necessary to use a separate microphone connected to line-in of the computer. 

IP camera brands

Media Recorder versions 2.5 and lower only supported Axis IP cameras. Media Recorder 4 supports all IP camera brands that 
support RTSP communication and produce an H.264 video stream. 

New supported device

Media Recorder 4 now supports the Basler acA1920-155um professional USB camera. 

Upgrade to Media Recorder 4

upgrade media recorder

To upgrade Media Recorder to version 4.0, insert the installation USB stick into your computer. Run the file Media Recorder 
4.0 Setup.exe. Media Recorder 4 does not overwrite a previous version of the software. We recommend to uninstall 
previous versions. 

Please take notice of the following notes:

 If you have a previous version of Media Recorder on a computer with another operating system than the 64-bit 
versions of Windows 7 or 10, you should either upgrade Windows, or install Media Recorder on a computer with one of 
these operating systems. If you have Windows 8.1, be aware that we performed only a quick test with this operating 
system.
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 After upgrading to Media Recorder 4, new settings should be made for the cameras. 

 The video files that were made with Media Recorder 2.0, or lower, were stored in the folder C:\Users\Public\Public 
Documents\Noldus\Media Recorder. Also after upgrading the videos are stored in this folder. However, if Media 
Recorder 4 is installed on a computer that did not contain a previous Media Recorder version, the video files are stored 
in the folder C:\Users\Public\Public Documents\Noldus\Media Recorder\Video Files. This location can be changed in 
the main Media Recorder window. 

upgrade recording devices

Upgrade device drivers

Some recording devices come with new drivers. Since the old drivers were not tested with Media Recorder 4, we cannot 
guarantee that they work. We recommend to uninstall the old drivers with Windows Programs and Features. To do so, 
open the Control Panel and select Programs and Features. Locate the driver of your recording device and click Uninstall. 
Then install the new camera drivers. See the section on your recording device how to do so. 

Upgrade firmware

Some recording devices may have new firmware. Check the website of the manufacturer of the recording device whether 
new firmware is available. Install the new firmware. 
11



Chapter 2
Specifications

System requirements...................................................................................................................................  13

Supported devices ....................................................................................................................................... 14

Video formats .............................................................................................................................................. 14
12



System requirements

operating system
Media Recorder 4 supports Microsoft Windows 7 64-bit Professional edition with Service Pack 1 and Windows 10 64 bit 
Professional edition. It has been thoroughly tested with the Windows 7 and 10 U.S. English language packs. It is possible 
that certain local language versions of Windows may affect how well the program runs. A quick scan was also carried out 
with a Windows 8.1 64-bit Professional edition. 

Media Recorder is not designed for use with the Windows Touch features. 

computer
Media Recorder 4 has been tested with a Dell Precision™ T5810 PC. If you order a complete solution from Noldus 
Information Technology, you will obtain this computer, or its successor, with Media Recorder software installed and ready 
to use. 

Technical specifications Dell Precision™ T5810 PC:

 Processor: Intel Xeon E5-1620 v3 (Quad Core), 3.5 GHz.

 Internal memory: 8 Gb.

 Hard disk: 1 TB.

 Graphics card: 2 Gb NVIDA Quadro K620, resolution 1920 x 1200.

Media Recorder 4 has also been tested on a Dell Precision™ M4800 laptop with the following devices:

 2 Axis M1054 IP cameras (Portable Observation Lab).

 1 Microsoft LifeCam Studio and 1 Epiphan DVI2USB 3.0 screen capture device (Portable Usability Lab).

 1 Basler acA1920-155um USB 3.0 camera.

Technical specifications Dell Precision™ M4800 laptop:

 Processor: Intel Core I7-4800QM (Quad core), 2.7 GHz.

 Internal memory: 8 GB.

 Hard disk: 500 GB.

 Graphics card: 2 GB NVIDA Quadro K2100M, resolution 1920x1080.

Media Recorder 4 has also been tested on a Dell Precision™ 7510 Mobile Workstation with the following devices:

 2 Axis M1054 IP cameras (Portable Observation Lab).

 1 Microsoft LifeCam Studio and 1 Epiphan DVI2USB 3.0 screen capture device (Portable Usability Lab).

Technical specifications Dell Precision™ 7510 Mobile Workstation:

 Processor: 6820HQ (i7 2.70GHz 4-core)

 Internal memory: 8 GB.

 Graphics card: Nvidia Quadro M1000M, 2 GB GDDR5 memory.

 Hard disk: 500 GB.

For more information on the Portable Observation Lab and Portable Usability Lab, consult the Reference 
Manual on the desktop of the notebook. 
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Supported devices

Media Recorder has extensively been tested with the following devices:

Analog cameras

Analog cameras in combination with a Euresys Picolo U4, or U8 H.264 frame grabber card. 

IP cameras

 Axis P5515 

 Axis M1054

 Axis P5534

 Axis M5014

 USB cameras

 Microsoft LifeCam Studio USB 2.0 camera

 Basler acA1920-155um USB 3.0 camera

FireWire camera

The Imaging Source DMK 21AF04 for the DanioVision system with FireWire camera. 

GigE camera

Basler acA1300-60gm monochrome camera.

Combinations

 Portable Observation Lab (two M1054 IP cameras).

 Portable Usability Lab (one Microsoft LifeCam Studio and one Epiphan DVI2USB 3.0 screen capture device).

 Stationary Usability Lab (three IP cameras and one Epiphan DVI2PCIe screen capture device).

Keyboard

CH products RS Desktop joystick for Pan, Tilt, and Zoom control of IP cameras.

Video formats

The video format Media Recorder creates, depends on the input:

 Analog cameras - Video files in H.264 AVC in an MPG container. 

 IP cameras – Video files in H.264 AVC with audio in AAC in an MP4 container.

 Other digital cameras – Video files in MPEG-4 DivX with audio in AAC in an MP4 container.

 Picture in Picture, or Picture by Picture; all video formats – Video files in MPEG-4 DivX with audio in AAC in an MP4 
container. See video file options on page 43 for more information on the options Picture in Picture and Picture by 
Picture. 

MPEG-4 DivX

MPEG-4 can achieve a high rate of compression with good quality, because it separately codes the background (which does 
not change much from frame to frame) from the moving parts of the video. MPEG-4 is in fact best seen as a collection of 
definitions rather than one fixed file format, and there are many different implementations of MPEG-4. MPEG-4 has a 
14



higher compression rate than for example MPEG-2 and it can have much higher resolution (with Media Recorder up to 1920 
x 1080 pixels). 

Media Recorder creates MPEG-4 DivX video files from several digital recording devices (see above). DivX is an 
implementation of MPEG-4 which has both high quality and good compression. MPEG-4 DivX decoding software for 
playing back the video files is installed with Media Recorder.

H.264 AVC

H.264 AVC is a type of MPEG-4 and is also known under the names H.264/AVC, AVC/H.264, H.264/MPEG-4 AVC, MPEG-4/
H.264 AVC, MPEG-4 Part 10 or x.264. It creates good video quality and uses previously-encoded pictures as references in a 
much more flexible way than in other standards, allowing the use of up to 16 reference frames. Media Recorder creates 
H.264 AVC video files from output of analog and IP cameras (see above). H.264 decoding software for playing back the 
video files is installed with Media Recorder.

video playback
Media Recorder videos play back in Microsoft Windows Media Player if you have installed the Mainconcept decoder 
package from the Media Recorder installation disc. This decoder package is automatically installed when you install Media 
Recorder. 

Videos from analog cameras

On computers with Windows 10, some Windows Media Player codecs need to be disabled to be able to play back the H.264 
video files with an MPG container Media Recorder creates from analog cameras. These codecs are disabled by Media 
Recorder installation. De-installing Media Recorder restores the Windows Media Player codecs. Contact Noldus Support if 
you want to play back the videos from analog cameras on another computer than the one with Media Recorder. 
15
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License key

A license for Media Recorder comes with a hardware key, which determines which license options are 
available to you (see modules on page 9). This is a very important piece of equipment, as it 
represents the full value of your license and cannot be replaced if lost. You can install Media Recorder 
on every computer. However, to work with the program you need to insert the license key into one of 
the computer’s USB ports.  

The drivers for the license key are installed together Media Recorder. It is important to install Media Recorder with the 
drivers for the license key before you connect the license key to the computer. If you connect the license key first, drivers are 
automatically installed which leads to incorrect functioning of the license key. When the license key is installed and 
connected properly, a red light glows inside it. 

The steps to install Media Recorder

Before you can start working with Media Recorder, you need to follow these steps:

1. Turn off automatic updates for device drivers (page 17).

2. Install Media Recorder and device drivers (page 20).

3. Install Media Recorder and device drivers with the Media Recorder setup prerequisites (page 20).

Turn off automatic updates for device drivers

Although the general recommendation from Microsoft to use automatic updates is good, especially for security updates, 
automatic updates of hardware device drives can sometimes give problems. The procedure below describes how to 
specifically turn off the automatic updates only for device drivers. If you ordered a computer with Media Recorder from 
Noldus IT, the automatic updates for device drivers have already been turned off. 

Please make sure that you do not lose the key! You will need to pay for a new license if so. Also be careful with 
the hardware key. It is sensitive and can be easily damaged.

Do not insert your license key before the installation is complete. If you do so, drivers are automatically 
installed, which leads to incorrect functioning of the license key. Drivers of the license key should be installed 
using the installation disc (see below).
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Windows 7
1. From the Windows Start menu, go to Devices and Printers

2. Right-click the icon of your computer and select Device installation settings.

3. To the question Do you want Windows to download driver software and realistic icons for your devices?, select No, let 
me choose what to do and then

If you do not see Devices and Printers, open the Windows Start menu and type Devices and Printers. 
18



4. Select Never install driver software from Windows Update.

5. Click Save Changes.

Windows 10
1. Open the Start window and type Change Device Installation Settings.

2. Click the tile that appears 

3. To the question Do you want Windows to download driver software and realistic icons for your devices?, select No, let 
me choose what to do and then

4. Select Never install driver software from Windows Update. 

5. Also deselect the checkbox in front of Automatically get the device app and info provided by your device manufacturer. 

6. Click Save Changes.
19



Install Media Recorder and device drivers

To start the installation of Media Recorder:

1. Insert the Media Recorder installation USB stick. Run the program Media Recorder 4.0 Setup.exe. 

2. We recommend to choose Standard as Installation type. Choose Custom only to change the location where the program 
is installed, or if you do not want a shortcut to the program on the desktop or start menu. 

3. In the Drivers and tools field, choose the driver of your video device. Choose N-Linx agent if you want to control 
recording with The Observer XT. 

4. Click Next, accept the License Agreement and click Install.

The following setup prerequisites are installed automatically before Media Recorder is installed:

• Sentinel Run time — Needed for correct functioning of your license key. 

• Noldus MediaLooks AV Filters 4.0 — Needed for several features of Media Recorder, like Picture-in-picture videos, 
synchronization of audio and video, and screen capture of the monitor of the computer with Media Recorder. 

• Noldus Mainconcept Encoder Package 7.7.10 — Needed to create MPEG-4 DivX video files.

• Noldus MainConcept Codec Package 8.5.32— Needed for audio encoding, MPEG-4 DivX decoding, and H.264 AVC 
decoding. 

• Noldus LAV audio filter 1.0.6 — Needed to play back AAC audio. 

• Microsoft .NET Framework 4.5.1 —To run Media Recorder. This program is installed only when not already present on 
the computer. 

• Microsoft_VC120_CRT—To run Media Recorder. 

If you have both The Observer XT and Media Recorder, install The Observer XT first. 
20
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Recording devices

Media Recorder is supported with the following devices types. See the section on the device type which specific video 
device has been tested. 

 Analog cameras (page 22).

 IP cameras (page 24).

 USB cameras (page 27).

 The DanioVision FireWire system (page 29).

 GigE cameras (page 30).

 Screen capture devices (page 31).

Analog cameras

when do you need an analog camera?

There are circumstances in which analog cameras are a better solution than digital cameras. If cables longer than 5 m are 
needed between the camera and recording equipment, for most digital cameras, you need an amplifier. Industrial analog 
cameras are in these cases often more suitable. Cable lengths of 30-50 meter are generally no problem. An exception is 
GigE cameras, that also can have very long cables. 

An additional advantage of analog cameras is that their signals can easily be splitted by simply splitting the cable. To split 
a signal from a digital camera a video splitter of video splitting software is needed. 

frame grabber board

Together with Media Recorder you can purchase a Euresys Picolo H.264 video capture card, to create video files in H.264/
MPEG-4 AVC format from analog videos. Since the encoding is done by the video capture card, the performance of your 
computer does not suffer from creating H.264 video files. 

Install the board

If you bought a complete solution from Noldus IT, the frame grabber board is present in the computer. If you bought your 
cameras, frame grabber board and Media Recorder separately, you must install the board into your computer. See 
Appendix E on page 78. 

Drivers

To install the drivers for this device, browse to the folder Drivers and Tools\Drivers\Euresys\UxH264 on the Media 
Recorder installation USB stick. Run the file picolo-u4-u8-u16-h264-win-2.5.0.139-ds-driver.

supported analog cameras

Tested cameras

 Ikegami ICD49 

 Ikegami ICD49E

 The camera from the PhenoTyper Top Unit (EIA). 

 The camera from the PhenoTyper Top Unit (CCIR). 
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CCIR is monochrome PAL and EIA is monochrome NTSC.

Maximum supported number of cameras

 Euresys Picolo U4 H.264 card – Three Ikegami ICD49 (E) or PhenoTyper Top Units (EIA/CCIR).

 Euresys Picolo U8 H.264 card. – Six Ikegami ICD49 (E) or PhenoTyper Top Units (EIA/CCIR). 

You need the Additional camera module 1-6 cameras in order to record with more than four cameras simultaneously. If you 
have this module, you cannot select channels 4 and 8 in Media Recorder. 

Processors

The Euresys Picolo U4 H.264 card has one processor and the U8 card has two processors. If you use more than three 
cameras per processor, the video capture card may drop frames, which can be as high as 25%. For accurate tracking in 
EthoVision XT, all video frames are needed. To see which card you have, count the number of cables attached to the 
connector. The U4 card has six cables and the U8 card has ten cables. 

 U4 – Use maximally three Top Units or other analog cameras

 U8 – Use maximally six Top Units or other analog cameras. Use maximally three cameras per processor. Therefore, use 
the cables numbered with 1,2,3 and 5,6,7. 

Audio

Media Recorder 4 is supported with analog cameras for use in EthoVision XT only. Recording audio with the Euresys Picolo 
H.264 card is not supported. 

Supported setups

*Media Recorder automatically identifies the analog cameras as PAL, or CCIR (=monochrome PAL) or NTSC, or EIA 
(=monochrome NTSC). It selects the correct frame rate and resolution automatically. 

Device Maximum 
supported 
frame rate 
(fps) *

Maximum 
supported 
resolution *

Maximum 
number of 
devices

Maximum 
supported 
recording 
time (hrs)

Supported 
on

Desktop 
(D)/ 
Laptop (L)

Supported 
with

Analog 
PAL/CCIR

Euresys 
Picolo U4 
H.264

25 704 x 576 3 24 D EthoVision XT

no audio

Analog  
NTSC/EIA

Euresys 
Picolo U4 
H.264

29.97 704 x 480 3 24 D EthoVision XT

no audio

Analog 
PAL/CCIR

Euresys 
Picolo U8 
H.264

25 704 x 576 6 

(cables 1,2,3, 
and 5,6,7)

24 D EthoVision XT

no audio

Analog 
NTSC/ EIA

Euresys 
Picolo U8 
H.264

29.97 704 x 480 6

(cables 1,2,3, 
and 5,6,7)

24 D EthoVision XT

no audio
23



Cable length

In theory, a length of 250 m should be possible, however we did not test that. We know that a length of 100 m can be used 
without problems. 

notes

Fast startup

By default the computer has the option to start up fast enabled. This can sometimes cause Media Recorder to stop 
responding when selecting an input of the H.264 frame grabber board. Open the Control panel select Power Options and 
then Choose what the power button does. Click Change settings that are currently unavailable and finally under 
Shutdown settings deselect Turn on fast startup (recommended).

IP cameras

when do you need an ip camera?

IP cameras are connected directly to a network. IP cameras are especially useful to film for example at a remote location 
and receive the video files through an ethernet network on your computer. 

install and setup

If you bought a complete solution from Noldus IT, the network adapter is present in the computer, the IP cameras are set up 
and the Media Recorder settings are made. If you bought your cameras and Media Recorder separately, you must do the 
installation and setup yourself. See Appendix F on page 81.

supported ip cameras

Tested cameras

 Axis P5515 

 Axis P5534

 Axis M1054

 Axis M5014

Network requirements

To use Media Recorder with IP cameras, an Intel Pro/1000 CT or Intel Pro/1000 PT (1 Gb) network adapter needs to be 
installed in the computer. The cables must be suitable for Gigabit Ethernet. The minimum cable quality is CAT5e (https://
en.wikipedia.org/wiki/Category_5_cable).

Please note that the file size of a 24 hours recording is very large (at least 12 Gb). 
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Supported setups 

Cable length

In theory a cable length of 150 m should be possible. However we did not test that. We know that a setup with a cable of 1 
m and an extension cable of 25 m with a switch between the cables works well with Media Recorder.

notes

ONVIF

ONVIF is a communication standard for network devices. ONVIF Profile S applies video and audio streaming and PTZ 
control. Most IP cameras nowadays support ONVIF Profile S. For cameras that do so, pan, tilt, and zoom control can be done 
with Media Recorder and audio from the camera can be recorded. For cameras that do not support ONVIF, pan, tilt, and 
zoom control must be done with a browser and audio must be recorded with a microphone connected to the sound card of 
the computer. 

Device Maximum 
supported 
frame rate 
(fps)

Maximum 
supported 
resolution

Maximum 
number of 
devices

Maximum 
supported 
recording 
time (hrs)

Supported 
on

Desktop (D)/ 
Laptop (L)

Supported 
with

Axis IP P5515 25 1920 x 1080 4 3 D The 
Observer XT

Axis IP  
M 5014

25 1280 x 720 1 3 D The 
Observer XT

Axis IP 
M1054

25 1280 x 720 8 3 D The 
Observer XT

Axis IP 
M1054

25 1280 x 800 2 1 L The 
Observer XT

Axis IP P5534 25 1280 x 720 1 3 D The 
Observer XT

Axis IP P5515

 

DVI2PCIe

25

25

1920 x 1080

1920 x 1080

3

1

3 The 
Observer XT
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Power supply 

IP cameras can be connected to a 1 Gb POE (Power Over Ethernet) or POE+ switch to supply them with power. This way no 
extra power cables are needed. Each device is connected to one channel on the switch. A POE switch can deliver up to 15 
Watt per channel. A POE+ switch has a higher capacity per channel (up to 30 Watt per channel). Make sure that the 
maximum total capacity of the switch is high enough for all cameras together. 

Example - you connect four cameras that need 30 Watt each to a POE+ switch. This POE+ switch must deliver at least 4 x 30 
= 120 Watt. 

 Axis P5515 – requires a regular POE switch. 

 Axis M1054 – requires a regular POE switch. 

 Axis IP P5534 –requires a POE+ switch.

 Axis M5014 – requires a regular POE switch.

USB devices

general information on usb devices

Supported devices

The following USB devices are supported with Media Recorder:

USB cameras (see page 27)

 Microsoft LifeCam Studio.

 Basler acA1920-155um USB 3.0 camera.

Screen Capture Device (see page 31)

 Epiphan DVI2USB 3.0.

USB ports

The Microsoft LifeCam Studio is a USB 2 device and can be connected to a USB 2 or USB 3 port on your 
computer. The other supported USB devices are all USB 3 devices and need to be connected to a USB 
3 port. You recognize these ports by a double-S in front of the USB icon. 

The Dell Precision T5810 desktop PC sold by Noldus IT has both USB 2 and USB 3 ports. The Dell Precision M4800 laptop has 
only USB 3 ports. 

USB hub

Do not connect your cameras to a USB hub. If you run short of USB connections, connect your license key, keyboard or 
mouse to a USB hub and connect your USB device directly to the USB port on your computer. 

Hot plugging

If you disconnect a USB device and connect it to another USB port, the name is shown twice in the list of devices. This is 
caused by the fact that Windows treats it as a new device. In this case you have to re-select the device in the Settings 
window (see The Settings window on page 40) and reselect all settings for the device. In general we recommend not to 
disconnect and connect recording devices while Media Recorder is running. In addition, always connect the same USB 
device into the same port. 

Cable length

USB devices can be connected to the computer without an amplifier with a cable of 5 m. For every subsequent 5 m an 
amplifier must be used. In theory, when using a standard resolution, the cables could be extended this way to 30 m. 
However we know that not all devices support this. Extending the standard 1 m USB cable with three 5 m cables with 
amplifiers works well for a Microsoft LifeCam Studio with Media Recorder.
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USB cameras

when do you need a usb camera? 

USB cameras are very easy to use. However, the settings may limited. As an example, with many USB cameras you cannot 
zoom. A USB camera may be perfectly suitable for a usability study in which you film a person sitting behind a computer. A 
USB camera also works very well to create video files for FaceReader. For creating a video file from a person further away 
from your camera, a USB camera may be less suitable. 

For videos with accurate time information, needed for EthoVision XT, you need a high-quality USB camera. 

supported usb cameras

Tested cameras

 Microsoft LifeCam Studio

 Basler acA1920-155um

microsoft lifecam studio

To install the camera drivers

For the Microsoft LifeCam Studio USB camera, choose Microsoft LifeCam Studio driver in the Drivers and Tools field of the 
Media Recorder installation window. Alternatively open the Media Recorder installation USB stick and: 

Windows 7 – Browse to Drivers and Tools\Drivers\Microsoft Life Cam\Win7 and double-click the file LifeCam 3.60.exe.

Windows 10 – Browse to Drivers and Tools\Drivers\Microsoft Life Cam\Win10 and double-click the file Noldus Microsoft 
LifeCam Driver 4.25.529.exe.

basler usb 3.0 camera

USB 3.0 card

Media Recorder was tested with the following USB 3.0 interface card: U3-PCIE1XG205 -1S. 

important If you use multiple USB 3.0 cameras, you need a USB 3.0 interface card for every camera. 

If you bought the camera together with a computer from Noldus IT, this card has been installed. If you bought the camera 
and computer somewhere else, you need to install this card yourself.

The procedure to install the USB 3.0 card is comparable to installing a GigE card. See install the ethernet card on page 93 
for the full procedure. In summary:

1. Turn off your computer and all connected peripherals, such as the monitor and printer. Make sure that the computer is 
unplugged.

2. Remove the PC's case according to the instructions provided in the PC's user manual.
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3. Select a free PCIe expansion slot, and remove the corresponding extension cover. See install the ethernet card on page 
93 for an overview of the properties of different slots. 

4. Place the USB 3.0 into the slot, and press it carefully into position.

5. Fix the card to the chassis and re-fit the computer's cover.

To install the USB 3.0 card driver

Do this if you install the card on a computer with Windows 7. 

1. Insert the Media Recorder USB stick in one of your PC’s USB ports. 

2. Browse to Drivers and Tools\Drivers\Renesas 3.0 Host Controller Driver and double-click RENESAS-30230-setup.exe. 
Follow the instructions on your screen.

3. Proceed with To Install the USB 3.0 camera driver below.

To Install the USB 3.0 camera driver

Choose Basler Camera driver in the Drivers and Tools field of the Media Recorder installation window. 

If you already installed Media Recorder, insert the installation USB stick into the computer. Browse to 
Drivers\Basler\5.0.5.8999 and double-click the file Basler_pylon_5.0.5.8999.exe. Follow the instructions on your screen to 
install the driver. During installation you are asked to choose the user profile. Select Camera user. Also, you must select the 
camera type. Select USB. 

Settings for the USB 3.0 camera

Follow the procedure in configure the camera (gige and usb 3.0) on page 105 to center the camera view, and select the 
camera gain and exposure time. 

Supported setups

Device Maximum 
supported 
frame rate 
(fps)

Maximum 
supported 
resolution

Maximum 
number of 
devices

Maximum 
supported 
recording 
time (hrs)

Supported 
on

Desktop 
(D)/ 
Laptop (L)

Supported 
with

Basler USB 
acA1920-
155um

60 1920 x 1200 1 24 D EthoVision XT

Basler USB 
acA1920-
155um

60 1920 x 1200 1 10 L EthoVision XT

Basler USB 
acA1920-
155um

40 1920 x 1200 4 24 D EthoVision XT

Microsoft 
LifeCam 
Studio

30 1280 x 720 1 1 L The  
Observer XT

Microsoft

LifeCam 

Studio

DVI2USB 3.0

30

30

1280 x 720

1920 x 1200

1

1

1 L The  
Observer XT
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The DanioVision FireWire system 

what is daniovision?

The DanioVision is an observation chamber for video tracking of zebrafish larvae in well plates. The current DanioVision 
makes use of a GigE camera, which is supported with Media Recorder. Previous DanioVision system had an analog camera, 
which is supported with the Euresys Picolo H.264 frame grabber card, of a FireWire camera. Media Recorder also supports 
this older system with a FireWire camera.

supported firewire camera

Tested FireWire camera

The ImagingSource DMK 21AF04

Drivers

To install the camera drivers, browse to Drivers and Tools\Drivers\The Imaging Source\4.4.0.1 on the Media Recorder 
installation USB stick and run the file drvInstaller.exe. 

Supported setup

 

Cable length

In theory the standard cable of 4.5 m can be extended to 70 m. You need an amplifying hub for each extra 10 m. However, 
the option to extend the standard cable of 4.5 m with an extra cable with amplifying hub has not been tested for FireWire 
cameras and Media Recorder.

Please note that the file size of a 24 hours recording is very large (at least 12 Gb).

Please note that with multiple USB 3.0 cameras it takes a while before they become visible in Media Recorder. 
USB 3.0 cameras take time to initialize.

Device Maximum 
supported 
frame rate 
(fps)

Maximum 
supported 
resolution

Maximum 
number of 
devices

Maximum 
supported 
recording 
time (hrs)

Supported 
on

Desktop 
(D)/ 
Laptop (L)

Supported 
with

DanioVision 
FireWire 

60 640 x 480 1 24 D EthoVision XT

Please note that the file size of a 24 hours recording is very large (at least 12 Gb).
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GigE cameras

when do you need a gige camera?

GigE cameras are high-performance industrial cameras. They can have a higher frame rate and resolution than the other 
supported cameras. The images are sent unprocessed to the computer using a standard network cable (UTP). With a high 
frame rate and resolution this results in a very high transfer of data. You can connect a GigE camera directly to an ethernet 
card on your computer. In this way you can obtain very high quality videos. An important advantage of GigE cameras is the 
possibility to have long cables between the camera and the computer.

install and setup

If you bought a complete solution from Noldus IT, the network adapter is present in the computer, the GigE cameras are set 
up and the Media Recorder settings are made. If you bought your cameras and Media Recorder separately, you must do the 
installation and setup yourself. You find the procedure in the Appendix Set up GigE cameras on page 93. 

supported gige camera

Tested camera

Basler GigE cameras AC1300-60gm. 

Network requirements

To use Media Recorder with GigE cameras, an Intel Pro/1000 CT or Intel Pro/1000 PT (1 Gb) network adapter needs to be 
installed in the computer. The cables must be suitable for Gigabit Ethernet. The minimum cable quality is CAT5e (https://
en.wikipedia.org/wiki/Category_5_cable).

Supported setups

  

Device Maximum 
supported 
frame rate 
(fps)

Maximum 
supported 
resolution

Maximum 
number of 
devices

Maximum 
supported 
recording 
time (hrs)

Supported 
on

Desktop 
(D)/ 
Laptop (L)

Supported 
with

Basler GigE 
AC1300-
60gm

30 853 x 640 4  
Picture by 
picture

24 D EthoVision XT

Basler GigE 
AC1300-
60gm

30 1280 x 960 4  
Separate 
video files

24 D EthoVision XT

Basler GigE 
AC1300-
60gm

30 1280 x 960 1 24 D EthoVision XT

Please note that the file size of a 24 hours recording is very large (at least 12 Gb).

Please note that with multiple GigE cameras it takes a while before they become visible in Media Recorder. 
GigE cameras take time to initialize. 
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Cable length

In theory a cable length of 150 m should be possible. However we did not test that. We know that a setup with a cable of 25 
m works well with Media Recorder. 

Screen capture devices

when do you need a screen capture device?

You can easily follow what your test participant is doing on his or her computer with a screen capture device. This device 
provides you with high quality images of the screen at which the test participant is looking.

supported screen capture devices

Tested devices

 Epiphan DVI2USB 3.0 – A frame grabber device with which you connect the output of the video card of the test 
computer to a USB 3 port of the recording computer (see also USB ports on page 26). The device has inputs for VGA and 
DVI signals. It can be connected to a USB 2 or USB 3 port. But it can record with a higher frame rate (up to 30 fps) when 
connected to a USB 3 port.

 Epiphan DVI2PCIe – A frame grabber board that is inserted in a PCI express slot in the recording computer. The video 
card of the test computer is connected with a DVI cable to this frame grabber board. The DVI2PCIe has inputs for DVI, 
VGA and HDMI signals, but it has only been tested with DVI input. See Install the PCIe screen capture card on page 34 
to install the card into your computer. 

• MR Screen Capture device – A built-in screen capture device that is present if your Media Recorder license includes the 
MR Screen Capture Module (see page 34). 

Drivers

For the Epiphan screen capture devices, use the drivers from the Media Recorder installation disc. Do not download an 
update of the driver from the Epiphan website! Otherwise, the screen capture devices may not work properly in 
combination with Media Recorder.

To install the drivers, choose Epiphan Screen Capture driver in the Drivers and Tools field of the Media Recorder installation 
window. Alternatively, browse to Drivers and Tools\Drivers\Epiphan\VGA_DVI2USB\X64 on the Media Recorder 
installation USB stick and run the file setup.exe.

The built-in screen capture device does not require installation of device drivers. 
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Supported setups with the Epiphan devices

See page 35 for the supported setups with the MR Screen Capture Module.

 

Notes on frame rate and resolution

The actual frame rate of the recorded video is limited by the bandwidth of the screen capture device. It may be much lower 
than 25-30 frames per second. The DVI2PCIe can record with at least >15 fps, even at high resolution. And the DVI2USB 3 can 
record with at least 30 fps at high resolution. 

To record enough screen detail, we recommend to use these devices at high resolution. Media Recorder supports a 
resolution of 1920 x 1200. However, screen capture devices by default use the resolution of the screen of the test computer. 
To change the recorded resolution, change the resolution of the monitor of the test computer. 

Set the resolution to fixed

To avoid a change in resolution in the recorded video when the resolution of the test computer changes, you may want to 
choose a fixed resolution. With fixed resolution images from monitors with a lower or higher resolution will be scaled to 
the chosen resolution. This is especially useful if you record computer games, since the menu often has another resolution 
than the game itself. By fixing the resolution you make sure that the entire screen is recorded, even if the resolution of the 
test computer changes. 

Select other frame rate or resolution

You can temporarily change the frame rate and resolution in the Advanced Video Settings of Media Recorder. However, 
these settings are lost if you close Media Recorder. if you want to make permanent changes, follow the procedure below.

1. Locate the executable v2ugui2.exe. By default this is located in the folder C:\Program Files\Epiphan\Frame Grabber 
Software. 

2. Right-click it and select Properties. 

Device Maximum 
supported 
frame rate 
(fps)

Maximum 
supported 
resolution

Maximum 
number of 
devices

Desktop (D)

Laptop (L)

Maximum 
supported 
recording 
time (hrs)

Supported 
with

Axis IP P5515

 

DVI2PCIe

25

25

1920 x 1080

1920 x 1200

3

1

D 3 The 
Observer XT

Microsoft

LifeCam 

Studio

DVI2USB 3.0

30

30

1280 x 720

1920 x 1200

1

1

L 1 The 
Observer XT
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3. Open the tab Compatibility. Under Privilege level, select the checkbox Run this program as an administrator. Ask you 
system administrator for help if you do not have administrator rights on your computer.    

4. Connect the screen capture device.

5. Open the Epiphan capture tool.

6. Choose Capture > Configure device. 

7.  Open the tab DirectShow. 

8. Select the checkbox next to Fix resolution and choose a resolution from the list. 

To change the frame rate
1. Follow steps 1 to 7 above.

2. Select Limit frame rate to and enter the frame rate. 
33



Cable length

USB devices can be connected to the computer without an amplifier with a cable of 5 m. For every subsequent 5 m an 
amplifier must be used. In theory, when using a standard resolution, the cables could be extended this way to 30 m. 
However this will not work with a screen capture device. We know that extending the standard 1 m cable with one 5 m 
cable with amplifier works well with Media Recorder.

notes

Audio

If you want to record audio, connect a microphone to the sound card of your computer and select that source in Media 
Recorder settings. 

Install the PCIe screen capture card

The procedure to install the PCIe screen capture card is comparable to installing a GigE card. See install the ethernet card 
on page 93 for the full procedure. In summary:

1. Turn off your computer and all connected peripherals, such as the monitor and printer. Make sure that the computer is 
unplugged.

2. Remove the PC's case according to the instructions provided in the PC's user manual.

3. Select a free PCIe expansion slot, and remove the corresponding extension cover. See install the ethernet card on page 
93 for an overview of the properties of different slots. 

4. Place the screen capture card into the slot, and press it carefully into position.

5. Fix the card to the chassis and re-fit the computer's cover.

the built-in screen capture option

If your license includes the MR Screen Capture Module, you can record the monitor of the computer with Media Recorder. 
If you want to record the screen of another computer, use an Epiphan Screen Capture Device instead. 

Windows text size

The use of built-in screen capture option is supported with a Windows text size of 100 % or 125% (Control Panel > Display). 

If you change Windows text size to 125%, this may result in Media Recorder capturing only part of the screen. To solve this, 
do the following: 

 Windows 7 – Restart the computer. 

 Windows 10 – 

1. Make sure Media Recorder is not running. 

2. Open the folder C:\Program Files (x86)\Noldus\Media Recorder 4.

3. Right-click the file MediaRecorder.exe and select Properties. 
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4. Open the Compatibility tab.

5. Select Disable display scaling on high DPI settings and click Apply.    

Supported setups

Using the built-in screen capture is supported in the following situations:

 One monitor.

 Maximum resolution of the monitor that is recorded: 1920 x 1080.

 Laptop only. 

In addition to this, the following is supported.

 

To select screen capture settings

To selected screen capture settings, like the frame rate or resolution, see use the built-in screen capture option on page 
47.

Device Maximum 
supported 
frame rate 
(fps)

Maximum 
supported 
resolution of 
the output file

Maximum 
number of 
devices

Desktop (D)

Laptop (L)

Maximum 
supported 
recording time 
(hrs)

Microsoft

LifeCam 

Studio

Built-in screen 
capture

30

30

1280 x 720

1920 x 1080 

1

1

L 1
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The main window

To get started, first connect your video devices and, optionally, microphones and other hardware and then start Media 
Recorder. The main window opens with a black screen that contains a warning triangle with the message No signal from 
Video 1; Please configure a device first. Furthermore, the table under this black screen is empty and also contains a warning 
triangle. This is because no video cameras are selected yet. You select the cameras in the Settings window (see page 40). 

The main window of Media Recorder contains the following features:

1. Table with cameras and settings — This table is filled in once you selected cameras (see select a video device on page 
41). Optionally, select and deselect video sources for recording.  
Optionally, select a checkbox in the Mute column to mute the audio from a video source during preview. The muted 
audio is recorded normally in the video files.

Optionally, show columns with the frame rate, resolution and format. To do so, right-click one of the column headers 
and select the preferred options. 
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2. File location — By default the video files are stored in the folder D:\Noldus\Media Recorder\Video Files.  
Optionally, use these buttons to change the location. The left button sets the folder to store the video files in, 
the right button opens this folder. 
You must be able to write in the selected folder and there must be enough file space available (at least 500 Mb per video 
per hour for MPEG-4 DivX and 600 Mb per video per hour for H.264 AVC files).

3. File base name — The name of the video file consists of the File base name followed by: 
-the video input name. 
-the date and the time the videos were recorded. 
-the number of the video camera. 

Example – The File base name is Video, you changed the name of Video 1 to Webcam in the Settings window (see The 
Settings window on page 40), the date is 11 May 2016, the time 10:54:43 and you create 2 videos simultaneously. The 
video name will then be: 

Video Webcam 5_11_2016 10_54_43 AM 2.mp4

The date and time depend on your computer’s regional settings. To change these, open the Control panel and then 
Region and Language. Select your preferences in one of the tabs.

4. Settings button — To select your cameras and their settings. See The Settings window on page 40 for further details. 

5. Refresh button — To show the camera signal after, for example, a temporary connection loss, or if you connected the 
camera after you started Media Recorder.  

6. Identify button — To view which video number in the table corresponds with which camera source. 
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Result — the video numbers are superimposed on the camera images. 

7. Recording button 

To start recording. You need to select all cameras first (see select a video device on page 41). 

The button now changes into the stop recording button and the status Not recording in the lower-left corner of 
your screen changes into a timer. 

8. Recording Properties bar — To hide or show all the features visible under the Preview window.  

The Settings window

To select your cameras and create their settings, choose File > Settings or click Settings. 
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The Media Recorder Settings window opens in which you can select the cameras, microphones, settings and options for the 
video files.  

Continue with select a video device below.

select a video device

1. Select your camera from the Video device list.  

2. Select the preferred frame rate and resolution. The options depend on your type of camera.    

If the Settings button is not visible, the recording properties may be closed. Click 
Recording Properties at the bottom of your window. By default the recording 
properties are open.

See Appendix F on page 81 how to set up IP cameras and select them in Media Recorder.  
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By default, the optimal combination of frame rate and resolution for the camera is selected. If you increase the frame 
rate, the maximum resolution available goes down and vice versa. If you select an impossible combination of frame 
rate and resolution and format, Media Recorder gives a warning (see below).

3. For advanced settings, click the video symbol next to the name of your camera. The available options depend on 
your camera. For some cameras you can zoom and adjust settings for brightness and contrast in this window. 

4. Optionally change the names in the Video name column, to, for example, Webcam, or IP camera. 

5. Optionally, continue with select an audio device below.

select an audio device

Audio is needed and has been tested only for cameras that are supported with The Observer XT. 

1. Select the microphones under Audio device. Choose between your computer microphone, a separate microphone, or 
the audio stream of your cameras. Choose No audio to not record audio.

2. Optionally record the same audio stream in all videos. To do so, select this checkbox. 

3. Click the microphone button for Audio settings. 

4. The available options depend on your microphones. Move the sliders to adjust the recording volume. 

To check the recording volume, right-click the speaker icon in the bottom-right corner of your window and select 
Recording devices. 

To show and hide the columns Frame rate and Resolution, right-
click a column headers and make your selection. This way you 
can also show the column Format. This column is hidden by 
default, because the default options are optimal. The Format 
column shows the color format of video file. See http://
www.noldus.com/knowledge-base/what-color-space-format-
used-media-recorder for more information on color formats.
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Check that the green bar is maximal when speech level is normal.

5. Optionally, change the names in the Audio name column.

video file options

Specify the format of the recording timer. 

The recording timer is present in the lower-left corner of the main window. 

Optionally, set a maximum recording time. 

The maximum is 99:99:59 (hr: min: sec). However, see your camera type in Chapter 4 for the supported maximum 
recording time. 

Output settings

If you have selected more than one video source, several options are available. 

 Separate videos — One video file for each camera. 

 Picture by Picture — One video file with the images from each camera next or above each other. If possible, choose the 
same frame rate for all the videos. If you choose different frame rates the videos with the lowest frame rates may 
flicker and may not be suitable for use in The Observer XT, EthoVision XT, or FaceReader. The resolution of the resulting 
43



video is a sum of the separate videos, with a maximum of 1920 x 1280. See Picture by Picture resolution on page 111 
how the resolution of the resulting video is calculated. 

 Picture in Picture — One video file with a large image of the first camera with the images from the other cameras 
embedded in it. If possible, choose the same frame rate for all the videos. If you choose different frame rates the videos 
with the lowest frame rates may flicker and may not be suitable for use in The Observer XT, EthoVision XT, or 
FaceReader. 

If you select the option Picture in Picture the following options become available:
- PiP Position — The position of the embedded images.
- Pip Size — The size of the embedded images. The percentage is based on the width of the first camera image. The 

aspect ratios of the embedded camera images are maintained.  
Please note that if you have multiple videos in portrait format, they may overlap when you use Picture in Picture. 

- Pip Margin — The margin of the embedded images. When the percentage is zero, the embedded images are 
positioned directly on the edge of the main image. The percentage is based on the width of the first camera image. 
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Record

When all cameras are selected and settings are made in the Settings window, click OK. The Media Recorder main window 
now shows the selected cameras and microphones and a preview of the videos. 

Optionally, change the order of the video cameras by dragging and dropping rows. Click the Refresh button after you have 
done this. 

Press the Start Recording button to start a recording. The button changes into the Stop Recording button and the 
Recording timer starts running.

   

Recording stops when the maximum recording time has reached, or when you press the Stop Recording button. 
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Additional options

save the settings

The settings you create for the different cameras are automatically saved when you close Media Recorder. They are saved 
to the file Current settings.mrs that is present in the folder D:\Noldus\Media Recorder. These settings are used when you 
restart Media Recorder. To save your settings under a different name, open the File menu and select Save Configuration 
As..... This way you can create different settings for, for example, a webcam for the test participant’s in the usability test 
room and an overview IP camera in a debriefing room. To open such a settings file, choose Open configuration... from the 
File menu. 

To restore the default settings

To go back to the default configuration, open the File menu and select Open Configuration. Browse to the file Default 
Settings.mrs. This file is read-only. You can find this file in the folder D:\Noldus\Media Recorder. 

If you encounter problems with starting Media Recorder, for example because you created wrong settings which are loaded 
when you start Media Recorder, delete the file Current settings.mrs. Media Recorder now starts with the default settings 
and you can create new settings.

use command lines 

With command lines, Media Recorder can be controlled with other programs like The Observer XT (see Observe live and 
control Media Recorder on page 50), or any other program that can send command lines, like the Windows Task Scheduler 
(see Appendix D on page 76).

1. Open CMD window:

 Windows 7 - From the Start menu enter cmd in the Start Search field and click Enter. 

 Windows 10 - Type Run in the Start screen with tiles and click the tile Run. Enter cmd in the window that opens. 

2. Type CD C:\Program Files (x86)\Noldus\Media Recorder 4\

3. Type the command and press Enter.

The following actions can be controlled with commands:

 Start Media Recorder – MRCmd.exe (no parameter after the executable) or MRCmd.exe /E 

 Start recording — MRCmd.exe /R 

 Stop recording —MRCmd.exe /S 

 Close Media Recorder — MRCmd.exe /X — Closes Media Recorder program. 

 Load a configuration file — MRCmd.exe /C=[filename.mrs] 

 Set the file base name — MRCmd.exe /B=[basename] 

There is a space between the file name and the slash.

Delay

Allow enough time between sending the command Start Media Recorder and Start Recording. If the command Start 
Recording is sent before Media Recorder is completely open, it does not work. 

There may be a delay between the command Start Recording and the moment the recording actually starts. This delay 
depends on the number of cameras, camera settings, the processor speed and programs running in the background. In the 
most common scenarios with Media Recorder and The Observer XT, the videos are automatically synchronized with the 
events. See Synchronization of videos with events on page 60 for more information.

Never shut down the computer by pressing the power button or cutting off the electricity. Your settings may 
become lost, even after you saved your project. Always use the Windows shut down feature to close your 
computer. 
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Load a configuration file

The command /C loads a configuration file with the settings for your cameras (see Additional options on page 46). This is, 
for example, useful to open Media Recorder with the correct cameras. Make sure Media Recorder is not recording at that 
moment. 

By default MRCmd.exe loads a file from the folder C:\Users\Public\Public Documents\Noldus\Media Recorder. If the file is 
located in another folder, you must type the full path. If the file name or the path contains spaces you must type it in 
between quotation marks. 

Example 1 - Command for opening Media Recorder and loading the configuration file Configuration_observation_room.mrs 
that is located in the folder C:\Users\Public\Public Documents\Noldus\Media Recorder. 

MRCmd.exe /E /C=Configuration_observation_room.mrs 

Example 2 - Command for opening Media Recorder and loading the configuration file Configuration Control Room that is 
located in the folder C:\Configuration files

MRCmd.exe /E /C=”C:\Configuration files\Configuration Control Room.mrs”

Set file base name 

The command /B sets the File base name (see page 39). 

Example - Command for opening Media Recorder and setting the File base name to Observation room. 

MRCmd.exe /E /B=”Observation room”

use the built-in screen capture option

If your license includes the MR Screen Capture Module, you can record the monitor of the computer with Media Recorder. 
See the built-in screen capture option on page 34 for the supported options. 

To use the Software Screen Capture option:

1. Choose File > Video Settings. 

2. From the Video device list, select Medialooks Screen Capture.

3. Click the Advanced Video Settings button to select recording options.  
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4. In the Medialooks Screen Capture Properties window that opens, select 
the frame rate and resolution in the Output field. See the picture on the 
right to use the screen capture option at full HD.

Although you can select a high frame rate, the actual frame rate of the 
recording will depend on the processor speed of your computer. Most 
likely this will be in the order of magnitude of 10 frames per second. 

5. Although this window has several recording options, the use of the built-
in screen capture is designed and supported to record the full screen of 
the primary monitor of the Media Recorder computer only. Minimize 
Media Recorder after you start recording. 

Disabled settings

As soon as you select the screen capture device, it is used for the video 
preview and you cannot change it’s settings. The Output fields are grayed 
out. To enable the fields again: 

1. Close the Medialooks Screen Capture Properties window. 

2. From the Video device list choose Select video device... and click Apply. 

3. Reselect the Medialooks Screen Capture device again and click the video icon to re-open the Medialooks Screen Capture 
Properties window (see step 3 above). You can now change the frame rate and resolution again. 
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How to record video for The Observer XT

You can create videos for use in The Observer XT in two ways. You can either first create videos in Media Recorder and then 
observe offline in The Observer XT. You can also control video recording with commands from The Observer XT together 
with a live observation. 

Observe offline

Offline observing in The Observer XT means carrying out an observation from prerecorded video. The video files created by 
Media Recorder can be used to observe offline in The Observer XT 10.0 or higher. No special settings are needed to use files 
from Media Recorder in The Observer XT. 

Observe live and control Media Recorder

You can score live in The Observer XT and record video with Media Recorder simultaneously. The Observer XT can send 
commands to Media Recorder (see use command lines for an overview of the commands). This way you can start and stop 
recording automatically when you start and stop an observation. Besides the fact that this is convenient, the videos are 
also automatically synchronized with your observations when you follow this procedure. 

The Observer XT can also send a command to automatically load a configuration in Media Recorder when you create a new 
observation, for example to select the correct IP cameras. 

Observe live and control Media Recorder 

The procedure to start and stop Media Recorder with commands from The Observer XT differs for The Observer XT 13 
(below) and The Observer XT 12.5 or lower (page 57). 

with the observer xt 13 and 14

Media Recorder 4 and The Observer XT 13 and 14 can communicate with each other with the Noldus network 
communication protocol N-Linx. This way you can achieve the following: 

1. When you create a new Observation, Media Recorder starts and loads a configuration (see page 46). 

2. When you start an Observation, Media Recorder starts recording. 

3. When you stop an Observation, Media Recorder stops recording. 

4. The recorded videos are automatically linked to the observation and synchronized with the events. 

You must do the following: 

1. If Media Recorder and The Observer XT run on different computers, create exceptions for port 5672 on both computers 
(page 51).

2. Install The Observer XT.

3. Install N-Linx agent on the computer with Media Recorder (page 51).

4. Create settings in Media Recorder (page 51).

5. Create settings in The Observer XT (page 51).

6. If Media Recorder and The Observer run on different computers, create a mapped folder on both computers where 
Media Recorder stores its video files (page 55). 

Opening Media Recorder requires time. When a command Start recording is sent before Media Recorder is 
open, the recording does not start. So make sure Media Recorder is open when you want to start recording.
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Exceptions for N-Linx port in Windows Firewall

Follow this procedure only if Media Recorder runs on a different computer than the one with The Observer XT. 
Communication with N-Linx runs through port 5672 on both computers. You need to allow inbound and outbound traffic 
through port 5672 in Windows Firewall on both computers. 

1. Open the Control Panel and select Windows Firewall.

2. On the left side of the window, click Advanced Settings.

3. Click Inbound Rule and click New Rule in the Actions pane. 

4. In the New Inbound Rule Wizard Window that opens, select Port and click Next. 

5. Select TCP and enter 5672 in the Specific local ports field and click Next.    

6. Click Allow the connection and click Next.

7. Select to which network the rule applies and click Next.

8. Give the rule a name, for example N-Linx connection and click Finish. 

9. Check in the Inbound Rules windows that this rule is set to Enabled.

10.Click Outbound Rule and click New Rule in the Actions pane. 

11. Repeat steps 4 to 9 for the outbound rule. 

12. Close all Control panel windows. 

Install N-Linx agent
1. First install The Observer XT. 

2. Insert the Media Recorder installation USB stick into the computer and run the file Media Recorder 4.0 Setup. exe.

3. In the Media Recorder installation window, choose N-Linx agent in the Drivers and tools field. If Media Recorder is 
installed on the computer already, choose Modify. Alternatively, open the folder Drivers and Tools\Software\N-Linx 
Agent and run the file N-Linx Agent Setup.exe.
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The N-Linx agent starts Media Recorder when you create a new observation in The Observer XT.  

4. Follow the instructions on your screen to install Media Recorder and N-Linx agent. N-Linx agent is installed in the folder 
C:\Program Files (x86)\Noldus\N-Linx Agent 1.

5. When done, N-Linx Agent opens automatically. If not, click the arrow in the bottom-right corner of your window to open 
the system tray. 

6. Double-click the N-Linx Agent icon.

7. If Media Recorder runs on the same computer as The Observer XT, you can enter Localhost in the N-Linx address field. 
Leave the default port 5672, unless your system administrator tells you otherwise. 

If Media Recorder runs on another computer than The Observer XT, enter the name of the computer with The Observer 
XT. To find that name, open the Control Panel and choose System. 

You can also enter the IP address, but then the IP address of the computer with The Observer XT must be fixed. Ask your 
system administrator for assistance. 
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If the connection with The Observer XT computer is found, the Status will become Connected and the N-Linx Agent 
Settings window will close.   

If you did not install The Observer XT yet, it will not be possible to establish a connection. Install The Observer XT and 
try to connect again. 

Media Recorder Settings
1. In Media Recorder, choose File > N-Linx settings.

2.  Select Allow communication with N-Linx.

3. In the N-Linx address field, leave the default value Localhost if Media Recorder runs on the same computer as The 
Observer XT. If both programs are on different computers, enter the computer name of the computer with The Observer 
XT. (see step 7 on page 52). 

4. In the N-Linx port field, leave the default port 5672. Ask your system administrator for assistance if this port is used by 
another program.

5. Click OK. The connection settings are tested. When the connection with the N-Linx agent is established the text 
Connected successful appears briefly and the window closes. If not, enter the correct settings and click OK again. 

The Observer XT settings
1. Make sure that Media Recorder is open before you make these settings.

2. In The Observer XT, open your project and choose File > Preferences > N-Linx Settings. 
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3. Select Use N-Linx server to connect with other applications. 

4. In the Services address field, leave the default value Localhost. 

5. In the Services port field, leave the default port 5672. Ask your system administrator for assistance if this port is used by 
another program.

6.  Click Test connection. If connection with N-Linx is found, the Status will change to Connected. If not, enter the correct 
settings and click Test connection again.

7. Click OK.

8. Choose Setup > Project Setup. 

9. Select Live Observation. The Devices window now opens. If not, click the Devices button. 

10.  Select Media Recorder and click Edit Settings. When you close Media Recorder, the Media Recorder line in this window 
will be grayed out and the status will change to Disabled. Media Recorder will be started when you create an 
observation.   

11. A window with the available Media Recorder configuration files (see Additional options on page 46) now opens. Select 
the configuration file you want to use and click OK. If you do not select a configuration, Current Settings.mrs will be used 
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see Additional options on page 46). With The Observer XT, you can also enter a name in the Identify device as field. This 
way you can control multiple Media Recorders with The Observer XT. This is only possible with The Observer XT 14.

Create a mapped drive for the folder with videos

Follow this procedure only if Media Recorder and The Observer XT run on different computers. 

On the computer with Media Recorder: 

1. Right-click the folder where the video files are going to be stored, and select Share with and then Specific People. 

2. Click the arrow next to Add and select Everyone and then click Add. 

3. Select Read/Write as Permission level and click Share > Done. 

On both computers:

1. Open File Explorer and then This PC. 
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2. Click the Map network drive icon.  

3. Choose a name for the drive and browse to the shared folder. Make sure this is the same on both computers. Then click 
Finish. 

If you have multiple computers with Media Recorder, repeat this procedure for each Media Recorder instance. So if you 
control two Media Recorders with The Observer XT, create for example a mapped drive Z and Y on the computer with 
The Observer XT, a mapped drive Z on one Media Recorder computer and a mapped drive Y on the other Media 
Recorder computer.   

4. When you now start the computer with The Observer XT you need to enter the login details for the computer with 
Media Recorder. 

Troubleshooting

When Media Recorder control with The Observer XT does not function properly, check the following;

• On the computer with Media Recorder, check that N-Linx agent is running. See step 6 on page 52. If there is no N-Linx 
agent icon in the system tray, the program is not running. Then run the file NLinxAgent.exe in the folder C:\Program 
Files (x86)\Noldus\N-Linx Agent 1.

• On the computer with Media Recorder, check that the status of the N-Linx agent is Connected. If not, follow steps 5 to 7 
on page 52. 

• In Media Recorder, check that the checkbox Allow communication with N-Linx is selected (see step 2 on page 53). 

• In The Observer XT, check that Use N-Linx server to connect with other applications is selected (see step 3 on page 54) 
and that the Status in the window is Connected (see step 6 on page 54). 

• In The Observer XT, check that Media Recorder is selected (see step 10 on page 54). 

• On both computers, check that an exception is made in Windows Firewall for all inbound and outbound traffic through 
port 5672 (see page 51).
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• On the computer with The Observer XT, check that RabbitMQ is running. To do so, press Ctrl + Shift + Esc and open the 
Services tab. Locate the line RabbitMQ and check that the Status is Running. If not, right-click the line and select Start. 

with the observer xt 12.5 or lower

The Observer XT can send commands to Media Recorder. This way you can achieve the following:

1. When you create a new Observation, Media Recorder starts. and, optionally, loads a configuration file (see page 46). 

2. When you start an Observation, Media Recorder starts recording. 

3. When you stop an Observation, Media Recorder stops recording. 

4. The recorded videos are automatically linked to the observation. 

5. If The Observer XT and Media Recorder run on the same computer, the videos are automatically synchronized with the 
events. 

You must do the following:

1. Specify Media Recorder as external device in the Observer XT (page 57).

2. Set automatic linking of video files (page 59). 

3. If Media Recorder and The Observer XT run on different computers, synchronize the videos with the events (page 62). 

Specify Media Recorder as external device in The Observer XT
1. In The Observer XT, choose Setup > Project Setup.

2. Under Observation Source, choose Live Observation. The Devices window opens. If not, click the Devices button. 

3. Click the Add External Program button. In the Add External Program window that opens, under Name, type in a name 
for the commands (only for viewing purposes). For example, Control Media Recorder.   

Opening Media Recorder requires time. When a command Start recording is sent before Media Recorder is 
open, the recording does not start. So make sure Media Recorder is open when you want to start recording.
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4. Select the checkbox next to New Observation. 

5. In the same row, click the ellipsis button and browse to  
C:\Program Files (x86)\Noldus\Media Recorder 4\MRCmd.exe. 

6. In the same row, leave the Command line options field empty. You can also type the command /E in this field. This 
results in The Observer XT starting Media Recorder, if it is not already open, when creating a new observation.

7. To load settings for your cameras automatically (see Load a configuration file) when you create an observation in The 
Observer XT, enter /C in the Command line options field for New Observation.  
If the configuration file is not located in the folder C:\Users\Public\Public documents\Noldus\Media Recorder, you 
must type the full path. If the file name or the path contains spaces you must type it in between quotation marks (See 
also Load a configuration file).  
Example - to open Media Recorder with the configuration Settings IP cameras observation room in D:\Noldus\Media 
Recorder 4: 
Enter the command:  
/E /C=”D:\Noldus\Media Recorder 4\Settings IP cameras observation.mrs” 

8.  Select the Start observation checkbox. 

9. In the same row, click the ellipsis button and browse to  
C:\Program Files (x86)\Noldus\Media Recorder 4\MRCmd.exe. 

10. In the same row, type the command /R in the Command line options field. This way recording starts when you start an 
observation in The Observer XT.

11. Select the Stop observation checkbox. 

12. In the same row, click the ellipsis button and browse to  
C:\Program Files (x86)\Noldus\Media Recorder 4\MRCmd.exe. 

13. In the same row, type the command /S in the Command line options field. This way recording stops when you stop an 
observation in The Observer XT.

14. If you have The Observer XT 11.5 or higher, leave the fields in front of ms before at the default value 0. The videos are 
automatically synchronized with the events in The Observer XT. 

If you have an older version of The Observer XT, enter the delay between the moment The Observer XT sends the 
command and the moment Media Recorder starts or stops recording. See Determine the time difference between 
video and events on page 62 how to determine this delay.

Use this option to, for example, switch between a webcam and an IP camera. Make separate device settings 
in The Observer XT for each configuration. Select the appropriate checkbox in the Devices window (see the 
picture below) before starting a new observation. Make sure Media Recorder is not recording when you 
load a new configuration by starting a new observation in The Observer XT. Also make sure Media Recorder 
is fully open before you start a new observation.
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The Add External Program window will look like this: 

15. Click OK. A new row Control Media Recorder appears in the Devices window. 

Specify automatic linking of video files 
1. Select Automatic linking of video files in the Devices window.  

2. The Automatic Linking of Video Files window opens. If not, click Edit settings. 

3. Video linking folder – Browse to the folder where Media Recorder stores its video files. By default, the media folder of 
The Observer XT is selected. However this is not the default folder to which Media Recorder saves its media files. Media 
Recorder saves its files by default in the folder 
D:\Noldus\Media Recorder\Video Files

4. Link video extensions – Make sure that *.mp4 and *.mpg are included.

5. Link video based on – Choose Video start time (later than observation start time). This lets The Observer XT search for 
video files that are saved after the observation start time.

6. Search for – Specify here the number of video files Media Recorder creates simultaneously in one session. 

7. Stop searching after – Specify here the time The Observer XT should look for new media files. Maximum time is 600 
seconds.

8. Visualize audio of video files –To view the audio stream of the video files as waveforms.

If The Observer XT and Media Recorder run on different computers, use the program PsExec to send the 
commands from The Observer XT across a network. See the Technical Note Using PsExec with Noldus products 
for the procedure. You can download this technical note from www.noldus.com/downloads. 
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The Automatic Linking of Video Files window will look like this:  

Make sure the Automatic linking of video files option and the External command option are selected in the Devices 
window.  

Carry out an observation (see Chapter 4 of The Observer XT Reference Manual). After you stop the observation, the videos 
are imported into the observation and synchronized. 

 Synchronization of videos with events

Videos created by Media Recorder are automatically synchronized with the events in The Observer XT in the following 
situations:

 You use Media Recorder 4 and The Observer XT 13 and follow the procedure on page 50.

 You use Media Recorder 4 and The Observer XT 11.5, 12.0 or 12.5, and you follow the procedure on page 57.

In these situations an automatic offset is applied to the videos. See page 61 how to view this offset. 

You need to synchronize videos and events manually in the following situations:

 You start video recording manually and import the videos into The Observer XT. 

 You control Media Recorder with commands from The Observer XT 11.0 or an older version. 

See page 62 how to synchronize videos and events manually.

Opening Media Recorder requires time. When a command Start recording is sent before Media Recorder is 
open, the recording does not start. So make sure Media Recorder is open when you want to start recording.
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view the automatic offset

To view the Media Recorder and The Observer XT time information and the automatic offset, right-click the video in The 
Observer XT and choose Properties, The offset is used for automatic synchronization.   

If you start recording manually within 10 seconds after observation start

If use The Observer XT 11.5 or higher and you start Media Recorder manually within 10 seconds after the observation starts, 
an offset is automatically set when you import the videos. A message with the calculated offset is shown.  
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If you right-click the video in The Observer XT, the offset is also shown next to Recording details in the Video Properties 
window that opens.   

However, there can still be up to 1 second asynchronism between the observation and the video files. If that is a problem 
for the accuracy of your experiments, fine-tune the synchronization, following the procedure described below. 

Synchronize manually

To synchronize videos and events manually, first determine the time difference and then apply an offset. 

Determine the time difference between video and events

Make sure an event is recognizable in the videos and the event log. For example create a dummy behavior with a key code 
in the coding scheme. Carry out an observation and simultaneously record a video or the keyboard. Press the key of the 
dummy behavior. The event is recorded in the Event log and is visible in the video. 

Open the observation and scroll to the recognizable event in the video. Note the time difference of the event in the video 
and the event log. 

Apply offset
1. In The Observer XT, open the observation and click the Offset button on the toolbar. 

2. Select Numerical Offset to open the File Synchronization window.

3. Set the time difference in the Offset cell. For example, if the video started 0.2 seconds before the observation, enter 0.20 
seconds in the Offset field of the video. 

You can also use the SyncBox to assess the delay (see the Technical Note - The SyncBox - The Observer XT for more 
information). 
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Media Recorder videos in EthoVision XT

track from video file

Tracking from video file in EthoVision XT means acquiring tracks from prerecorded video. Media Recorder video files can be 
used to track From Video File in EthoVision XT as long as you use supported cameras. When you use analog cameras, you 
must adjust the aspect ratio. For digital cameras that are not supported this may also be necessary. See the adjust the 
video aspect ratio below. 

EthoVision XT can also send commands to start and stop recording with Media Recorder (see Control Media Recorder with 
Ethovision XT on page 66).

adjust the video aspect ratio 

1. In the EthoVision XT choose Setup > Experiment Settings. 

2. Choose From Video File as your Video Source. You find more information on how to make Experiment Settings in 
chapter 5 of the EthoVision XT Reference Manual. 

3. Choose Setup > Arena settings, or click the desired Arena Settings in the Experiment Explorer. 

4. Browse to your video file and grab a background image for your arena. See chapter 6 of the EthoVision XT Reference 
Manual for information on how to do this, and for more information on how to make Arena Settings. 

In principle you can create video files from many different digital cameras with Media Recorder. However, the 
quality of the digital camera is essential for accurate tracking. If you use other hardware or cameras than the 
supported ones, you need to check whether the time information in the video files is correct. See Appendix C 
on page 75 how to do this.
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5. Click the Adjust Aspect Ratio button.  

6. Depending on whether you use an analog, or a digital camera, the procedure differs. See Digital cameras on page 65 or 
Analog cameras on page 65. 

Digital cameras 

For the supported cameras, leave the default option Diligent controlled by EthoVision or video file with aspect ratio 
selected. For other digital cameras you may need to adjust the aspect ratio. See the section The video aspect ratio in the 
EthoVision XT Reference Manual for details. 

Analog cameras

In the Adjust Aspect Ratio window choose Noldus Recorder and click the dropdown list. Choose:  

• Euresys PICOLO U4 H.264 – NTSC — For analog NTSC cameras. NTSC cameras are found in North and Central America, 
together with parts of Asia.

• Euresys PICOLO U4 H.264 – PAL — For analog PAL cameras. PAL cameras are found in Europe and the rest of the world, 
except for North and Central America, together with parts of Asia.

The other options do not apply for video files created with Media Recorder. 
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Control Media Recorder with Ethovision XT

To control Media Recorder with commands from EthoVision XT, select MRCmd.exe as external program in the Trial Control 
Settings and specify the command. See use command lines on page 46 for an overview of the available commands. 

To track live in EthoVision XT and record with Media Recorder simultaneously, you either need two cameras, or have an 
analog camera connected to two channels of the Euresys Picolo H.264 card. 

1. Open the Trial Control screen by clicking the Trial Control Settings in the Experiment Explorer. For an extensive 
description of how to use Trial Control, see chapter 7 of the EthoVision XT Reference Manual or the Trial and Hardware 
Control - EthoVision XT Reference Manual. 

2. In the Components pane, under Actions click the button next to External command.  

3. Enter a name in the Action Name field, for example, Start Recording.   

4. Under Actions to perform, click the ellipsis button and browse to MRCmd.exe. By default MRCmd.exe is present in 
the folder C:\Program Files (x86)\Noldus\Media Recorder 4\MRCmd.exe. 

5. Enter one of the commands that are available for Media Recorder (/E, /R, /S, /X or no command) as a Command line 
option. 
Example - You carry out live tracking during a 24-hour period and you want to make a recording in Media Recorder but 
only when the animal leaves the shelter. 
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6. Create an external command condition with the command /E to start Media Recorder.   

7. Insert a Condition Out of shelter. Combine this condition box with a Time condition, because opening Media Recorder 
takes a few seconds. With a Time condition you make sure that Media Recorder is open before recording starts (see the 
figure below for an example). 

8. Insert an External command box with the command /R to start recording.  

Example of the External command action to start a recording with Media Recorder when the animal leaves a shelter. The 
left Start MR action box starts up Media Recorder. The Start recording MR action box on the right starts the recording 
when both the ‘Out of Shelter’ and ‘Time(1)’ conditions are true, that is, the center-point of the animal has left the shelter 
at least 5 seconds after Media Recorder was started. 

9. Similarly, you can stop recording (Command line option: /S) when the animal enters the shelter again.  

Opening Media Recorder program takes time. When a command Start recording is sent before Media Recorder 
program is open, the recording does not start. So make sure Media Recorder program is open when you want 
to start recording. 

There also may be a delay between the command Start Recording and the moment Media Recorder actually 
starts recording. This delay results in missed frames at the beginning of the video file. Run a test recording to 
test how long this delay is. To assess this delay, make for example a video of a digital clock and compare the 
time the command Start Recording is given with the time at the first frame of the video.
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Settings for DanioVision video recordings

aim

To improve the quality of video recorded, if the current quality is insufficient to track a large number of very small animals. 

background

Video tracking zebrafish larvae in 96 well plates works with a relatively low number of pixels per animal that may not 
contrast much with the background. For accurate tracking, a very good quality video is needed. 

The default settings for encoding video with Media Recorder ensure very good quality video. However, for video tracking of 
zebrafish larvae with a DanioVision Observation Chamber, this quality may still not be good enough. This quality can be 
further improved by adjusting compression settings for MPEG-4 recording in the Windows registry. Please note that this 
gives a lower compression and, therefore, a much larger video file size. The file size can be ten times as large as with the 
default quality settings. 

procedure

You can change the quality settings in the Windows registry. To do so, run the file MCMPEG4EncQ33G15.reg. This file is 
present on the Media Recorder installation USB stick in the following folder:

Drivers and tools\Software\DanioVision

You can also download the file from the Media Recorder 4 section of www.noldus/downloads. 

This adds the following registry entry:

 [HKEY_CURRENT_USER\Software\MainConcept\MainConcept MPEG-4 Video Encoder]

"[RC] Quantizer for I-Frame"=dword:00000003

"[RC] Quantizer for P-Frame"=dword:00000003

"[GOP] Gop length"=dword:0000000f

It sets the following settings for MPEG-4 recording:

 GOP Size = 15

 Quantizer for I-frame = 3

 Quantizer for P-frame = 3

To restore the default settings:

Run the file MCMPEG4EncOrig.reg that you find in the same folder as mentioned above. The default settings are:

 GOP Size = 15

 Quantizer for I-frame = 4

 Quantizer for P-frame = 8
68

www.noldus/downloads


69

Chapter 8
Media Recorder with FaceReader

Offline video analysis in FaceReader means analyzing prerecorded videos. The videos created by Media Recorder can be 
used for offline video analysis in FaceReader 4 or higher. No special settings are needed to use files from Media Recorder in 
FaceReader. 

You cannot simultaneously analyze live video signals in FaceReader and create video files in Media Recorder. If you want to 
analyze and record videos simultaneously, record the videos in FaceReader.



Appendix A
Troubleshooting

If you are having problems, please first read Requirements of a custom computer on page 73, to check that your system is 
suitable for using Media Recorder. This appendix contains troubleshooting items for the following cases. 

 no video preview (page 70).

 sound problems (page 70).

 insufficient disc space (page 71).

 synchronization problems (page 71)

 It also contains information on:

 tools for troubleshooting (page 71).

 help menu (page 71).

 technical support (page 72).

no video preview

If one of your video inputs is black with a warning triangle and the message like Error detected with Video 1 is shown, the 
video source was not turned on when Media Recorder was started. Press the Refresh button in Media Recorder to show the 
image from that camera. You also get a black screen with a warning triangle when you have not yet selected this camera in 
Media Recorder Settings window (see select a video device on page 41 for details).

bad video quality

If you split the input of one analog camera and connect them to two video channels on the Picolo H.264 encoder board, it 
may happen that one or more of the camera images is very bad quality. See set dip switches (only if you track live and 
record video simultaneously in mediarecorder) on page 78 for the solution. 

installation problems

If you get an error message during installation of the Picolo U4, or U8 H.264 card, it is most likely that the card is not 
correctly inserted into your computer. Turn the computer off and disconnect the power cable. Press the card gently but 
firmly into place.

sound problems

If you are playing back multiple videos in The Observer XT and you hear an echo on the sound track, turn the sound off on 
all but one of the video monitors.

If you hear no sound on your recording this could be because:

 The speakers of your computer are not plugged in, turned off or their volume is low.

 The Windows volume control is muted or turned low.

 You have selected Line -in for your audio device instead of Microphone. 

 You do not have an audio source connected.
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insufficient disc space

If your output folder is on the C: drive it is possible that you will have insufficient file space. Most computers are configured 
with more file space on the D: drive, so select your output folder on the D: drive.

synchronization problems

 If you have multiple videos that do not seem to be synchronized, use the offset function in The Observer XT to 
synchronize. If you send commands with The Observer XT to start and stop recording, the videos are automatically 
synchronized.

 If you miss frames at the beginning of your video when you sent commands to the Media Recorder with EthoVision XT, 
this is because of a delay in starting the actual recording with The Media Recorder. To assess this delay, make for 
example a video of a digital clock and compare the time the command “Start Recording” is given with the time at the 
first frame of the video.

tools for troubleshooting

Videoinspector

This free tool (http://www.kcsoftwares.com/?vtb) gives basic information about the video files you are trying to play (such 
as which codecs they were made with) and report which codecs are installed on your computer. It is reasonably easy to use. 
It does not report details such as the I-frame rate.

GSpot

Although GSpot (http://gspot.headbands.com) has not been maintained since 2007, it is a powerful tool to get information 
about both your video file and your computer system. Gspot is a free tool. It is less easy to use than VideoInspector.

In addition to providing detailed information about the video file you have opened, G-Spot can be used to adjust how 
Windows uses the codecs installed. This is an advanced function and you should only use it if you understand what you are 
doing, and carefully write down the changes you make. If several codecs are installed which can be used to play one format, 
Windows assigns a ‘merit’ to each codec to determine its preference. You can use Gspot to change the merit of each codec 
and in that way select which one is used by Windows (and so by other software). This is a way in which you can solve 
problems of codecs conflicting with each other, e.g. a piece of software such as The Observer XT works best with a 
particular codec, but another installation has set the merit of an alternative codec higher.  

Mediainfo

MediaInfo (http:/www.mediainfo.sourceforge.net/en) provides detailed information about media files. It has less 
information than GSpot, but at the publication date of this manual, it was maintained. 

Windows System Information

This can be obtained in Windows with System and Security/System/Advanced System Settings, Dxdiag.exe, and the Device 
Manager (in the Control Panel). 

For full system information, SIW is a useful tool (http://www.gtopala.com).

help menu

Media Recorder’s Help menu contains the following options:

 Help topics – Opens the Media Recorder Reference Manual. You can search and find help topics.

 Noldus Online – If your computer is connected to the Internet, you can choose this option to go to the Media Recorder 
home page, check for updates, contact the help desk or consult the data base of the Customer Support Center. If you 
encounter a problem with Media Recorder, you can inform Noldus IT with the Report an Issue option.  
On the Noldus web site you can also download documentation and drivers. Visit www.noldus.com/downloads. At this 
page you also find information about known problems and their solution. 
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 Upgrade – If you have purchased an upgrade of Media Recorder, choose this option to type the new Upgrade Key 
number that you have received from Noldus. 

 About Media Recorder– Choose this option to see details of exactly which version of Media Recorder you are using. 
Click User Info to see the registered user and license number of your software.

technical support

For questions about this or any other Noldus product, please check the support database or contact the Support 
department (www.noldus.com/support-center). You can also contact the Support Department by opening the Help menu 
in Media Recorder, select Noldus Online and subsequently Contact Help Desk. The help desk may ask for the file 
MediaRecorder.log. You can find this file in the folder D\Noldus\Media Recorder. 
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Appendix B
Requirements of a custom computer

recommended computer

If you order a complete solution from Noldus Information Technology, you will obtain a Dell PrecisionTM T5810 quad core 
workstation. This PC is the standard test platforms for Media Recorder, and we recommend that you use that computer. 
Media Recorder 4 is also used in the Portable Observation Lab and the Portable Usability Lab with a Dell PrecisionTM 7510 
quad core mobile workstation (or its successor). See computer on page 13 for the specifications of the Dell PrecisionTM 
T5810 and Dell PrecisionTM 7510. 

buying your own computer

If you are planning to purchase a different computer than the Dell Precision T5810, or 7510 please contact us for detailed 
advice.

We recommend that you do not use the following computers, as these have caused our customers problems in recent 
years:

 All HP (Hewlett Packard) computers

 Dell Optiplex

 Dell Vostro

 Low-end consumer models

 Dell dual core computers

Computer requirements

 Media Recorder supports Microsoft Windows 7 64-bit Professional edition with Service Pack 1 and Windows 10 64-bit 
Professional edition. A quick test was also carried out with Windows 8.1 64-bit Professional edition. 

 For working with Media Recorder and video (files or cameras), we recommend that you use a professional workstation. 
It is possible to buy consumer-range computers with a high processor speed and plenty of memory, but in order to 
remain competitive regarding price, the manufacturers often economize on the underlying system architecture. That 
means those computers are suitable for home use, but not for running professional scientific software. You should 
select a computer which is intended for professional use or labeled by the manufacturer as a workstation. 

 If you use an older desktop computer, it should have at least a 3.5 GHz Quad Core processor and at least 8 GB of 
memory. A laptop should have at least a 2.8 GHz Quad Core processor and at least 8 GB of memory.

 If you are scoring from video files on the hard disk, you need sufficient free space to store them (MPEG-4 at least 0.5 
GB/hr, and H.264 at least 0.6 GB/hr).

 For working with digital video, a good quality high-end video card designed for workstations is recommended. 

 We recommend to use a separate 1 Gb network adapter for the IP and GigE cameras and preferably the Intel Pro/1000 
CT or PT.
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To use the videos in Noldus software

 We strongly recommend to run a test recording of about 2 minutes and play it back in The Observer XT, EthoVision XT 
or FaceReader, before you start the actual recording. With this test recording you can also determine the delay between 
the moment you click the start button of Media Recorder and the actual start of recording.

 For The Observer XT you need the Media Module to be able to record and play back up to 2 video files simultaneous. 
You need the additional Multiple Media Module to play back up to 4 video files simultaneous.
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Appendix C
Testing a setup with Media Recorder 

If you want to use Media Recorder with an unsupported camera or computer, it is necessary to test the quality of the video. 
Low quality can be caused by dropping video frames, or the audio and video becoming out of sync, or two or more video 
cameras becoming out of sync. You can do this as follows:

1. Set a timer display running on a computer monitor (preferably with both digital and analog display) and play music 
(not on the same computer as Media Recorder). Make sure no background programs are running on the computer.

2. Make a recording in the normal way. Remember to plug in your microphone if you will be using audio.

3. After the normal maximum recording time, give an audio and visual cue (e.g. click your fingers) and stop the recording

4. Check the recording length in MediaInfo and number of frames in GSpot (see tools for troubleshooting on page 71). 
Use the frame rate to determine if any frames are dropped.

5. Go to the moment where you gave the cue and check if the audio and video are in sync, and if multiple videos are in sync. 

Note that a small error is not necessarily a problem (and is normal); it depends entirely on the accuracy with which the 
audio and video need to be scored.



Appendix D
Control Media Recorder at a predefined time

Windows 7 and 10 come with the program Task Scheduler. With this program you can control other programs at a 
predefined time. With the external commands you can control Media Recorder at a predefined time. This is especially 
useful when you want to start recording in the middle of the night, or you do not want to disturb the test subjects by 
handling the video software. 

The procedure below is an example of the possibilities of Windows Task Scheduler. Since this is a Microsoft program, 
Noldus IT offers no support for this feature. 

1. Windows 7 - Type Task Scheduler in the Search field of the Windows Start menu. Open the program Task Scheduler.  
Windows 10 - Type Task Scheduler in the Start window. Then click Schedule tasks. 

2. Choose Action > Create Task.

3. In the General tab, type a name in the Name field, for example Media Recorder with Webcam.

4. Optionally enter other settings in this tab and open the tab Triggers.

5. Click the button New. 

6. Select On a schedule from the list next to Begin the task:

7. Enter the start time of the command in the Start field and choose whether you want to send the command once, daily, 
weekly or monthly. The window will look like this:   

8. Optionally, enter Advanced Settings and click OK. 

9. Click the Actions tab and choose New. 

10.Choose Start a program next to Action.

11. Browse to MRCmd.exe.
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12. Enter the command in the Add arguments (optional): field. For example, to start Media Recorder and load the 
configuration file for your webcam, type: 

/E /C=Configuration_webcam.mrs 

If the configuration file is not located in the folder C:\Users\Public\Public documents\Noldus\Media Recorder, you 
must type the full path. If the file name or path contains spaces you must type it in between quotation marks (See also 
Load a configuration file on page 47). 

Your window will look like this: 

13. Optionally select or change any settings on the other tabs. 

14. Similarly, you can create tasks to start and stop recording at a predefined time with the commands /R and /S and to 
close Media Recorder with the command /X. Create a task for each command. 

By default, the tasks are stored in the folder Task Scheduler Library. To edit or delete a task, click this folder in the tree on 
the left side and select the task in the window Task Scheduler Library. In the Actions pane, click Properties, or Delete.

Allow enough time for Media Recorder to open. When a command Start recording is sent before Media 
Recorder program is open, the recording does not start.
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Appendix E
Install the Picolo U4, or U8, H.264 encoder card

the steps to install the picolo h.264 encoder card

If you ordered a computer and analog cameras from Noldus Information Technology when you purchased Media Recorder, 
the encoder board is already installed in your computer and its drivers are installed. You can connect your cameras and 
start recording. 

If you bought your computer somewhere else, you must insert the encoder board yourself. This involves the following 
steps:

 If you track live and save video in EthoVision XT, set the dip switches of the board to the correct position (page 78. 

 Install the card in the computer (page 79).

 Install the drivers for the card (page 80.)

set dip switches (only if you track live and record video simultaneously in 
mediarecorder)

If you track live and record video in Media Recorder simultaneously, you must split the analog video signal and connect it to 
two channels on the Euresys encoder card. The dip switches must then be set in the correct position. Make sure that for the 
video channels you use, one dip switch is set to ON and the other to OFF. The picture below shows which switch belongs to 
which video channel. 
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install card

The following steps are required to install the Picolo U4, or U8, H.264 encoder card. 

1. Make sure your computer is turned off and the power cable is disconnected. Open the computer.

2. Select a free PCIe expansion slot, and remove the corresponding extension cover. 
Different PCIe slots have different properties, resulting in different performances. When possible, choose the slot that 
gives maximum performance. To estimate performance, take note of the slot version (2, 3, etc.; see the figure below). Do 
not use the graphic slots (see also the drawing of the available slots).   

Detail of the PCIe slots in a Dell computer. 

3. Compare this number with the following table:
- PCIe v1.x: 250 MB/s
- PCIe v2.x: 500 MB/s
- PCIe v3.0: ~1 GB/s
- PCIe v4.0: ~2GB/s

Note that values are given per lane; they should not be multiplied by the number of lanes in a slot (e.g. x4) since the card 
has a 1x connector).   

Available PCIe slots in the Dell T5810 computer. 
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4. Unpack the Euresys Picolo H.264 card, place it into the slot, and press it carefully into position. If the card does not fit into 
place easily, remove it and repeat the operation.   

5. Fix the card to the chassis and re-fit the computer's cover. 

install drivers

1. Now install the Euresys card drivers. Insert the Media Recorder installation USB stick in the computer. Browse to the 
folder Drivers and Tools\Drivers\Euresys\UxH264 on the Media Recorder installation USB stick. Run the file picolo-u4-
u8-u16-h264-win-2.5.0.139-ds-driver.   

2. When a security warning appears, click Run and follow the instructions on your screen.

3. Click Close when the Operation Successful window appears. A message appears that your computer needs to be 
restarted. Click Yes.

When touching the board, its electronic components can be damaged by static electricity. To avoid any such 
risk, make sure that you are grounded. You can ground yourself by putting on an earthing wristlet, and 
attaching its clip to the metal frame of the computer. If an earthing wristlet is not available, you can hold the 
metal frame with one hand while holding the ethernet card in your other hand. Ensure also that your clothing 
does not touch any components while handling the card.
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Appendix F
Set up IP cameras

the steps to install ip cameras

If you ordered a computer and IP cameras from Noldus Information Technology when you purchased Media Recorder, the 
cameras are already installed. Also Media Recorder has been set up to use with these cameras. You can connect your 
cameras and start recording. 

If you bought your computer and cameras somewhere else, you must assign IP addresses to the cameras and create camera 
and Media Recorder settings yourself following the entire procedure below. 

If you bought your cameras from Noldus IT and installed Media Recorder yourself, the cameras are installed but you must 
set up Media Recorder. Skip the first sections in this appendix and go directly to set up media recorder for onvif devices 
on page 86 or set up media recorder for devices that do not support onvif on page 88. The Axis cameras sold by Noldus 
IT support ONVIF. 

In this appendix you find the instruction for Axis IP cameras. If you have other cameras, consult the camera manual. We 
recommend to use a dedicated 1 Gb network for the cameras. If you do not use the IP cameras with a dedicated network, 
consult your system administrator to obtain the correct IP addresses. Setting up IP cameras involves the following steps:

1. set computer ip address in range of camera (page 81).

2. create camera settings (page 82).

3. set up media recorder for onvif devices (page 86) or set up media recorder for devices that do not support onvif 
(page 88).

Furthermore this chapter contains the procedure for pan, tilt, zoom control of IP cameras that support ONVIF (page 90).

set computer ip address in range of camera

Follow the steps below for to set the IP address of the computer with Media Recorder in the range of the cameras.

1. Open the Control Panel and select Network and Sharing Center.

2. Click Change adapter settings on the left side of your window.  

3. Right-click the Local Area Connection and click Properties. If your computer has more than one Local Area Connection, 
choose the one with which the computer is connected to the cameras. To check which one this is, remove the cable from 
this IP port on your computer. The LAN connection that gets a red cross through it is the correct one.
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4. Select Internet Protocol Version 4 (TCP/IPv4) and click Properties.  

5. Click Use the following IP address and enter the IP address and Subnet mask supplied by your system administrator. 
Leave the other fields empty. 

6. Click OK and close the Control Panel. 

create camera settings

1. If you did not give your computers a fixed IP address yet, do so now. See set computer ip address in range of camera 
on page 81 for the procedure. Then go to step 2. 

2. Connect all cameras.

Set camera IP address

3. Insert the installation USB stick into your computer and copy the file IPUtility.exe from the folder Software\Axis Tools 
to your computer. Do not copy it to your desktop, the tool will then not work correctly. 
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4. Run IPUtility.exe. A window opens in which all the connected devices are listed. 

5. Right-click the device and select Assign IP address.  

6. Enter the IP address and choose Assign.

7. According to the message that appears, disconnect and reconnect the camera and click Assign. Wait until the IP address 
is set.

8. Right-click the camera and select Test IP address. When the details were entered correctly a message appears that the 
camera is accessible. 

9. Repeat steps 5 to 8 for all cameras. Make sure you use different IP addresses for all cameras and computer and other 
network devices in the network.

Set password
1. In the IPUtility tool, click the Home Page button. the camera now opens in a browser. 

You can also access this page by typing the IP addess in the address field of, for example, Internet Explorer.  

Close the browser before you start recording. Leaving it open may cause recording problems in Media 
Recorder. 
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If you do not get a view in Internet Explorer, click the Settings wheel in the upper-right corner of your window and 
choose Compatibility View Settings. Enter the IP address of your camera and click Add. Other browsers may have a 
comparable setting.  

2. The first time you open the camera in a browser, you must set a password. If you obtained cameras from Noldus IT, this 
password is Noldus.  The user name root cannot be changed. Do not use the characters @, space, or colon (:) for the 
password. These characters cannot be used in Media Recorder. 

3. As soon as you set the password, you must log in to the camera with the password you just set. 

Select power line frequency

The first time you log in in the camera, you must select a power line frequency. Look up the correct power line frequency of 
your country on Internet. 

Access camera settings
1. Open the camera in a browser by clicking the Home page button in the IPUtility tool (see step 1 on page 83) or typing 

the IP address in the address field of an internet browser. Then enter the password.

2. Click Setup at the top-right corner of your screen. 

Create ONVIF User name and Password

To use the pan, tilt, and zoom options in Media Recorder, you must create an ONVIF user in the camera. This option is, of 
course, only possible if your camera supports ONVIF. If the camera does not support ONVIF, pan, tilt, and zoom must be 
done with a browser. Always close the browser before you start recording with Media Recorder.

The procedure to create an ONVIF user in Axis cameras is described below. For other camera brands, consult the camera 
manual. 
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1. Open the camera settings (see Access camera settings on page 84).

2. Click System Options and then ONVIF.

3. Click Add and enter a User name and Password. Do not use the characters @, space, or colon (:) for the user name or 
password. These characters cannot be used in Media Recorder. If you obtained the camera from Noldus IT, the ONVIF 
user name is root and the ONVIF password is Noldus.

4. Select Administrator as User Group and click OK.   

Disable replay attack protection

Also Prevent that connection to the camera fails if the time of the Media Recorder computer differs from the time in the 
camera. For an Axis camera, the procedure is described below. Other camera brands may have a comparable setting. 
Consult the camera manual for the procedure.

1. Open the camera settings (see Access camera settings on page 84).

2. Under System Options, select Advanced. 

3. Click Plain Config.

4. From the list at the bottom, select WebService and click Select Group. 

5. Under WebService UsernameToken:, make sure the checkbox Enable replay attack protection: is not selected.    

Replay attack protection is necessary for security cameras, but not for IP cameras in a dedicated network. If you do not 
want to disable this option, make sure that the clock times of the computer and camera are exactly the same. 

IR cut filter
1. Open the camera settings (see Access camera settings on page 84).

1. Click Video & Audio and then Camera Settings. 

2. Check if there is an option IR cut filter. If so, set it to On. This avoids that the cameras switches to black and white at low 
light levels. 

3. Click Save. 
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Audio settings

To adjust the recording volume: 

1. Open the camera settings (see Access camera settings on page 84).

2. Choose Video & Audio > Audio Settings. 

3. In the Input Gain list, by default the value Auto is selected, which means that audio level is automatically adjusted by 
the camera software. To change the audio recording volume, select another value from the Input Gain list. Check that 
the green field in the Level field covers the entire range with normal speech in the location.    

What next?
1. Create all camera settings from create camera settings on page 82 onwards for each camera. 

2. Close the browser and the IPUtility tool. 

3. Continue with setting up Media Recorder. See either set up media recorder for onvif devices (page 86) or set up media 
recorder for devices that do not support onvif (page 88).

set up media recorder for onvif devices

If your device does not support ONVIF, continue with set up media recorder for devices that do not support onvif on 
page 88.

1. Open Media Recorder and choose File > Video Settings or click Settings.

2. Select the checkbox in front of the video channel and choose RTSP IP Camera (Noldus RTSP 
Source Filter). 

3. Click the Advanced Video Settings button.  

4. Enter the IP address, ONVIF User name and ONVIF Password for your camera. If you obtained cameras from Noldus IT, 
the ONVIF user name is root and the ONVIF password is Noldus.  
If you bought cameras yourself, Create ONVIF User name and Password on page 84 for the procedure to create an ONVIF 
user name and ONVIF password.  
If the default Port 554 is already in use, ask your system administrator for help to select another one. 
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5. Click Get device properties.  

6. The Encoding and Quality fields appears with the default video format, frame rate and resolution of the camera.  

7. Optionally, click Edit and select another frame rate or resolution. Click Update when done. It is possible to change video 
quality with Advanced settings, but recommend to only do this when problems with video quality or data transfer over 
the network occur. See Advanced video quality options on page 88 for an explanation of the options.   

It is also possible to change the frame rate and resolution in the table with selected video devices.   

In previous versions of Media Recorder, the tool OnvifProfileManager was used to change the frame rate 
and resolution of the camera. This is no longer necessary. We recommend not to use this tool anymore. 
Change the frame rate and resolution in the table with selected video devices (see picture above). 
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8. You may want to reverse the direction the camera moves with Pan and Tilt). To do so, select the checkbox Flip pan axis 
(horizontal movement) or Flip tilt axis (vertical movement) or both. 

9. Click OK.

10.To select the microphone from the camera, or a microphone connected to it, select RTSP IP camera (Noldus RTSP Source 
Filter) from the Audio device list. See Audio settings on page 86 how to adjust the recording volume.

11.  Continue with select a video device on page 41.

Advanced video quality options

If an option cannot be edited, your camera does not support other options, or the value is set by the chosen profile. 

• Encoding interval - This value cannot be edited and is set by the profile. 

• Bitrate - With this option you can set a limit to the data transfer. The default value 0 means unlimited. If you enter a 
value, data transfer is limited to this value in Kb per second.

• H264 Gov length -The interval in which the I-Frames (uncompressed images) will be coded in the video file. A value of 1 
means that every frame is an I-frame. A value of 2 means that every second frame is an I-frame. Decreasing the number 
increases the video quality, but also the data transfer. See https://en.wikipedia.org/wiki/
Video_compression_picture_types for a description of the frame types. 

• H264 Profile - The encoding profile from the IP camera. Media Recorder uses the Baseline profile and this option cannot 
be edited. 

• Quality - The quality of the encoded video file. Higher number gives higher encoding quality, but also more data transfer 
over the network. 

set up media recorder for devices that do not support onvif

1. Open Media Recorder and choose File > Settings or click Settings.
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2. Select the checkbox in front of the video channel and choose RTSP IP Camera (Noldus RTSP Source Filter). 

3. Click the Advanced Video Settings button.  

4. Enter the IP address and enter the User name and Password of the device. If you bought your cameras from Noldus IT, 
the User name is root and the Password is Noldus. 
If the default Port 554 is already in use, ask your system administrator for help to select another one.

5. Click Get device properties.  

6. The field Connection string appears. 

7. Look up in the manual of your device where the video files can be accessed via the RTSP communication protocol. Enter 
the path from the slash after the connection information in the Connection string field. For example, /stream.sdp for an 
Epiphan VGADVI broadcaster (Note that this device is not yet supported with Media Recorder).   

8. Click OK and, optionally, select another frame rate or resolution. However, make sure you select the same frame rate as 
is selected in the device itself when you opened the camera in a browser. 

9. Optionally, open the camera in a browser to pan, tilt, or zoom (see Access camera settings on page 84). Make sure you 
close the browser before starting recording with Media Recorder. 

10.Click OK and continue with select a video device on page 41.
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pan, tilt, zoom control

Pan, tilt and zoom is possible with IP cameras that support ONVIF. If you use the CH products RS Desktop joystick for PTZ 
control, make sure it is connected before you start Media Recorder.

If you hover with your mouse over the camera image, two buttons appear in the top-right corner of your window.  

PTZ control in Axis M1054, Axis P5515, and Axis P5534
1. Click the Enable PTZ button in the image you want to adjust. A four-arrow cross appears in the middle of the image 

and your mouse pointer becomes a small point. Click the camera image and keep your left mouse button pressed to 
control the camera. The cross now becomes connected to the point and the camera image moves in the direction of 
the point. The further away from the center cross you click, the faster the camera moves.   

To reverse the camera pan or tilt direction, open the Advanced Video Settings window and select the checkbox Flip 
Pan axis or Flip Tilt axis (see step 8 in the section set up media recorder for onvif devices on page 86).

2. Zoom in and out with your mouse wheel.

PTZ control in Axis M5014

To use PTZ control with an Axis M5014, the file Default Settings.mrs must be edited. When you ordered a complete solution 
from Noldus IT, this has already been done for you. To use PTZ control:

1. Click the Enable PTZ button in the image you want to adjust. 

2. A white cross appears. The camera moves to the point that you click with your mouse. 

3. Zoom in and out with your mouse wheel.  

Enable or disable PTZ control

Opens the PTZ preset menu
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When you ordered an Axis M5014 yourself, follow the procedure below to enter the correct settings in the file Default 
Settings.mrs:

1. Open Media Recorder and select your IP cameras (see set up media recorder for onvif devices on page 86).

2. Close Media Recorder.

3. Create a backup of the file Default Settings.mrs that is present in the folder C:\Users\Public\Public Documents\ 
Noldus\Media Recorder. 

4. Open the file Current Settings.mrs from the same folder with Notepad.

5. Locate the line <PtzType>1</PtzType> and change 1 to 0. There is a line for each PTZ camera that you selected in Media 
Recorder. Change the line for each Axis M5014 camera.

6. Save the file as Default Settings.mrs. These settings are used when the file Current Settings.mrs is not found. 

7. Delete the file Current Settings.mrs from the folder C:\Users\Public\Public Documents\Noldus\Media Recorder. 

8. Re-open Media Recorder. Media Recorder opens with configuration file Default Settings.mrs and creates a new file 
Current Settings.mrs with the edited settings. The new PTZ method is now available. 

PTZ presets

If you are satisfied with the position of your camera, you can save this as a PTZ preset. Click the button that opens the PTZ 
menu (see above). The following buttons now appear.  

The Save as buttons appear when you hover over the Return to PTZ preset buttons.

PTZ keyboard shortcuts

The following keyboard shortcuts can be used to control PTZ:

When you selected the same camera multiple times in Media Recorder, use the same method for pan and tilt 
in each camera. So for each camera, use either 1 or 0 in each Default Settings.mrs file. 

Save as first PTZ preset

Save as second PTZ preset

Return to first PTZ preset

Return to second PTZ preset

Shortcut key Camera action

Ctrl + 1 Enable / disable PTZ in first video

Ctrl + 2 Enable / disable PTZ in second video

Ctrl + 3 Enable / disable PTZ in third video

Ctrl + 4 Enable / disable PTZ in fourth video

Numpad 1 Move camera left-down

Numpad 2 Move camera down

Numpad 3 Move camera right-down

Shortcut key Camera action

Numpad 4 Move camera left

Numpad 6 Move camera right
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Shortcut key Camera action

Numpad 7 Move camera left-up

Numpad 8 Move camera up

Numpad 9 Move camera right-up

Numpad + Zoom in

Numpad - Zoom out
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Appendix G
Set up GigE cameras

the steps to install gige cameras

Together with the Basler GigE camera, you need an Intel PRO/1000 Ethernet card installed in your computer. 

important Please note that if you use multiple GigE cameras, each camera should be connected to its own 1Gb Ethernet 
card. 

If you ordered a computer from Noldus Information Technology when you purchased Media Recorder and the Basler GigE 
camera, the card has already been installed and tested. Also the settings for the computer and camera were made. In this 
case, you can connect your camera and start recording. 

If you bought your computer and camera somewhere else, you need to follow the entire procedure in this appendix to 
install the Ethernet card, make computer settings, and set up the camera. This involves the following steps:

 install the ethernet card (page 93).

 install media recorder with the camera drivers (page 95).

 set ethernet card ip address (page 95).

 disable windows firewall for the ethernet card (page 97).

 set camera ip address (page 98).

 what’s next? (page 105).

install the ethernet card

.

The ethernet card 

1. Turn off your computer and all connected peripherals, such as the monitor and printer. Make sure that the computer is 
unplugged.

2. Remove the PC's case according to the instructions provided in the PC's user manual.

3. Select a free PCIe expansion slot, and remove the corresponding extension cover. 
Different PCIe slots have different properties, resulting in different performances. When possible, choose the slot that 
gives maximum performance. To estimate performance, take note of the slot version (2, 3, etc.; see the figure below). Do 
not use a graphics slot (see also the drawing of the available slots).
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.   

Detail of the PCIe slots in a Dell computer.  

4. Compare this number with the following table:

• PCIe v1.x: 250 MB/s

• PCIe v2.x: 500 MB/s

• PCIe v3.0: ~1 GB/s

• PCIe v4.0: ~2GB/s

Note that values are given per lane; they should not be multiplied by the number of lanes in a slot (e.g. x4) since the card 
has a 1x connector).   

Available PCIe slots in the Dell T5810 computer. 
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5. Unpack the Ethernet card, place it into the slot, and press it carefully into position. If the card does not fit into place 
easily, remove it and repeat the operation.  

6. Fix the card to the chassis and re-fit the computer's cover.  

install media recorder with the camera drivers

If you upgraded from a previous Media Recorder version and have old drivers for the camera installed, uninstall them first. 
To do so, open the Control Panel and choose Program and Features. Select the Basler camera driver and choose Uninstall. 

Install the camera drivers from the installation USB stick. In the setup window, choose Basler Camera driver in the Drivers 
and tools field. This is the same driver as for the Basler USB camera. Follow the procedure in Install Media Recorder and 
device drivers on page 20. 

If you already installed Media Recorder, insert the installation USB stick into the computer. Browse to 
Drivers\Basler\5.0.5.8999 and run the file Basler_pylon_5.0.5.8999.exe. Follow the instructions on your screen to install 
the driver. 

During installation you are asked to choose the user profile. Select Camera user. Also, you must select the camera type. 
Select GigE. 

set ethernet card ip address

1. Connect the camera with the ethernet cable to a Power Over Internet (POE) Switch and connect the POE Switch to the 
port of the Intel PRO/1000 ethernet card.

2. Open the Control Panel.

3. Go to Network & Internet and then Network and Sharing Center. 

When touching the board, its electronic components can be damaged by static electricity. To avoid any such 
risk, make sure that you are grounded. You can ground yourself by putting on an earthing wristlet, and 
attaching its clip to the metal frame of the computer. If an earthing wristlet is not available, you can hold 
the metal frame with one hand while holding the ethernet card in your other hand. Ensure also that your 
clothing does not touch any components while handling the card.
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4. Click Change adapter settings on the left side of your window.   

5. Right-click the Local Area Connection and click Properties. If your computer has more than one Local Area Connection, 
choose Basler GigE Vision Adapter. Write down the number of this connection.

6. Select Internet Protocol Version 4 (TCP/IPv4) and click Properties.  

7. Select the radio buttons Use the following IP address and Use the following DNS server addresses and fill in the details 
as shown in the figure below. Also select the checkbox Validate settings upon exit. When done, click OK and then Close. 
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8. A Windows Network Diagnostics window appears. Click Close when it is finished. Then close all windows. 

disable windows firewall for the ethernet card

1. Open the Control Panel and go to System and Security. 

2. Click Windows Firewall.  

3. Click Advanced Settings on the left side of your window.   
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4. Under Overview, click Windows Firewall Properties. 

5. Open the tab Public Profile. 

6. Click Customize next to Protected Network Connections.  

7. Deselect the checkbox in front of Local Area Connection. If there is more than one local area connection, check step 5 in 
the topic set ethernet card ip address on page 95 for the correct local area connection. 

8. Repeat the steps 5 and 6 for the Domain Profile and Private Profile tabs.

9. Click Close.

10.A warning balloon appears in the bottom-right of your window. Wait untill this message has disappeared. 

11. Close all windows. 

set camera ip address

1. Open Pylon IP Configurator (x64). Ignore the warning that the device is unreachable.
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2. Select the camera under Local Area Connection.  

3. Fill in the details in the IP Address and Subnet Mask fields under Static IP Address as shown in the figure below. Make 
sure the last number differs from the last number of the Ethernet card (see set ethernet card ip address on page 95). If 
you have multiple cameras, make sure the last numbers differ from each other as well. As an example, give the Ethernet 
card the number 192.168.1.51 and the cameras the numbers 192.168.1.101; 192.168.1.102 etc. 

4. Click Save and then Close. 

gige cameras; important notes

 Each camera should be connected to a separate 1Gb Network adapter, through its own PoE-injector. See install the 
ethernet card for details. 

 Each camera must always be connected to the same adapter, because the IP address of the camera and that of the 
adapter are linked, and this information is stored in the driver software of each camera. If you swap cameras, they will 
not be recognized. Therefore, label the adapters and cameras.

TIP rename the adapters in the Control Panel, for example Front camera and Top camera.
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 Each camera must have a unique IP address. The third set of numbers should be different between cameras. However, 
note that the third set of numbers must be the same for the camera and its own adapter. See below for an example.

Camera 1: 192.168.1.101 associated with network adapter with IP 192.168.1.51

Camera 2: 192.168.2.102 associated with network adapter with IP 192.168.2.52.

In Pylon IP configurator, the first camera looks like this.

 The cameras should have the same Firmware version. Check this in the Pylon viewer. To do so: In the Features panel, 
under Device Information, check Firmware Version. If the two (or more) cameras do not have the same firmware, an 
upgrade/downgrade must be done. 

 Noldus does not support recording from a GigE camera connected to a laptop computer.

configure the camera (gige and usb 3.0)

To access the camera settings (general)
1. Make sure Media Recorder (and EthoVision XT, when present on the computer) are not running.
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2. Start the Basler Pylon Viewer software that comes with the Basler camera.

NOTE  The Basler Pylon Viewer software is installed automatically when you install the camera drivers.

3. Choose Tools > Options and check that the User level is set to Expert or Guru.

4. In the Devices panel, under GigE, double-click the Basler camera.

5. To preview the camera image, click the Continuous Shot button on the toolbar. 

NOTE  To be able to adjust the settings, click the Stop button first.

6. Follow the instructions below that apply.

To center the camera view

With this procedure you make sure the camera view is centered.

IMPORTANT  If you center the camera view in Media Recorder, the settings are not stored in the camera drivers. Here in 
Pylon viewer you make sure that the settings are stored in the drivers, also for future recordings.

1. In the Features panel, open the Basler camera item and then the Image Format Control item. 
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2. Select both options Center X and Center Y.

3. Save the settings. See To save the camera settings on page 105.

To adjust the camera exposure time

The exposure time (or shutter time) is the time the camera shutter is kept open to let light in. The exposure time limits the 
maximum achievable frame rate. If sum of the exposure time and the time needed for reading the chip (readout time) is 
greater than the time between consecutive video frames, the next frame may be dropped, resulting in a lower frame rate, 
and incorrect time in the video file.

To adjust camera exposure that matches a frame rate:

1. In the Features panel, open the Basler camera item and then double-click Acquisition Control.

2. Make sure that Exposure mode is Timed, and Exposure Auto is Off.

Next to Exposure Time (Abs) [us], enter the exposure time you require, in microseconds. Fast moving animals like 
zebrafish larvae, require short exposure times, 4000 or 2000. In all other cases, you may choose a higher value below 
20000.

Press Tab or click another field to confirm.

3. To check that the exposure time is compatible with your frame rate, click the Continuous Shot button on the toolbar. 
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4. At the bottom of the live video window, locate the frame rate resulting with the new exposure time. This should be the 
same as the one next to Acquisition Frame Rate (Abs) [Hz].
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If the resulting frame rate is lower than Acquisition Frame Rate (Abs) [Hz], then either lower the exposure time (this 
will make the video image darker; open the lens diaphragm to compensate for this), or lower the video resolution. Do 
this until you see the expected frame rate.

5. Save the settings. See To save the camera settings on page 105.

To adjust the camera gain

This applies to both color and black/white Basler cameras.

1. In the Features panel, click Analog Control.

2. From the Gain Auto list, select Off. 

3. Next to Gain (dB), select the value you require. A higher Gain results in a brighter image, but also more noise and a grainy 
image.

4. Save the settings. See To save the camera settings on page 105.
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To adjust white balance

If you have a color camera, you also need to adjust its white balance.

1. Click Color Improvements Control.

2. Point the camera at a piece of white paper, so that the camera image is entirely white. Click in the field next to Balance 
White Auto and select Once from the list.

3. Save the settings (see below).

To save the camera settings
1. Click the Stop button.

2. In the Features panel, open the User Set Control item.

3. Select User Set 1 from the Configuration Set Selector list.

4. Next to User Set Save, click Execute. The camera settings set in the previous steps are now saved under User Set 1. 

5. From the Default Startup Set list, select User Set 1.

6. Close Pylon Viewer.

These settings will be used each time you start up Media Recorder.

what’s next?

The settings are now complete. Continue with the chapter Media Recorder; general procedure on page 37.
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the media recorder settings file

The settings you create for the different cameras are automatically saved to the file Current settings.mrs. When you restart 
Media Recorder these settings are used. To save your settings under a different name, open the File menu and select Save 
Configuration As..... This way you can create different settings for, for example, The Observer XT, EthoVision XT, and 
FaceReader. You can also use Cyrillic, Chinese, or Japanese characters for the configuration name. To go back to the default 
configuration, open the File menu and select Open Configuration. Browse to the file Default Settings.mrs. This file is read-
only. You can find this file in the folder  
C:\Users\Public\Documents\Noldus\Media Recorder.

When problems occur with the current settings, you can delete the file Current settings.mrs from the folder  
C:\Users\Public\Documents\Noldus\Media Recorder.  
When you subsequently open Media Recorder, the file Default Settings.mrs is loaded and new file Current Settings.mrs is 
created in which the changes are saved. 

To edit the settings file

You should never edit the file Default settings.mrs. Always edit a copy, or edit the file Current settings.mrs. To do so, use the 
tool XML Notepad that you can download from www.microsoft.com/downloads. Editing the file Current settings.mrs is 
only possible if Media Recorder is closed. 

settings for euresys picolo h.264 frame grabber board

The following settings can be changed to improve video quality or to increase the compression of the video file for video 
files created from analog cameras in combination with the Euresys Picolo H.264 frame grabber board. 

 GOPSize — The GOP size is by default set to 15. It can be any value between 2 (largest file size) and 100 (smallest file 
size). The GOPSize defines the number of P- or B-frames between I- frames. Do not increase the GOPSize above 15, 
because that may lead to problems in The Observer XT, EthoVision XT, or FaceReader. If you enter an invalid value, like 1, 
Media Recorder will use the default value of 15. 

 Quality — The Quality is by default set to 85. It can be any value between 1 and 100. 1 is the lowest quality, 100 the 
highest. 

 AvgBitRateXCh — The average bit rate is by default set to 4000 Kb/s, when using 1 or 2 devices. For 3 devices it is 2666 
Kb/s and for 4 devices it is 2000 Kb/s. This is because the maximum throughput of the Euresys card is 8000 Kb/s. The 
value can range between 1 and 4000. A low value may give low quality video when images are moving or when lighting 
conditions are not good. A high value may lead to missing frames. 

 MaxBitRateXCh — The maximum bit rate is by default set to 4000 Kb/s when using 1 or 2 devices. For 3 devices it is 
2666 Kb/s and for 4 devices it is 2000 Kb/s. This is because the maximum throughput of the Euresys card is 8000 Kb/s. 
The value can range between 1 and 4000. A low value may give low quality video when images are moving or when 
lighting conditions are not good. A high value may lead to missing frames.
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Appendix I
Audio devices

which audio device should i use?
The appropriate audio device depends on your setup. Take the following rules of thumb into account: 

• For room settings, use one omnidirectional ceiling microphone. 

• For meetings around a table, use one boundary layer table microphone. 

• For usability research behind the computer, use a microphone close to the test participant, for example a wireless 
microphone or boundary layer table microphone.

• For very good audio quality for more than one test-participant, use a wireless microphone for each person. 

• Audio quality strongly depends on the room settings. An expensive audio device does not by itself guarantee good 
audio. If the devices are not placed correctly, or if the acoustics in the room is bad, audio quality will be suffer. 

• Do not place the microphone cables in the vicinity of 230 V electricity cables. If you, for example, place microphone 
cables in electrical conduits, the electricity can interfere with the audio. 

• Use, sound absorbing material, like curtains, to avoid echoes on audio recordings. 

preamplifiers
The signal from a microphone is of low voltage. This signal needs to be amplified prior to further processing, like mixing or 
recording. This is done with a preamplifier. The strength of the signal that is amplified this way, is called line-level. When 
you subsequently connect the preamplifier to the sound card of your computer, select Line in when a message pops up that 
a new devices is detected. 

The unamplified signal is very sensitive to noise. Therefore the preamplifier should be positioned as close to the 
microphone as possible.

When you use a digital video device and connect the audio directly to the sound card of the computer, the sound card of 
the computer functions as a preamplifier. So for recordings with digital devices, you can connect the microphone directly to 
the computer. When a message pops up that a new device is detected, select Mic-in as input source. 

balanced cables
In professional audio, a balanced line or balanced signal pair is a transmission line consisting of two conductors of the same 
type. Both lines have equal impedances along their lengths and equal impedances to ground and to other circuits. Both 

lines are twisted together and then wrapped with a third conductor (foil or braid) that acts as a shield. Common balanced 
cables are cables with XLR connectors. Balanced cables are the opposite of unbalanced cables. A coaxial cable is an example 
of an unbalanced cable.   

The main advantage of the use of balanced lines is good rejection of external noise. Because the signal between the 
microphones and preamplifier is most sensitive to noise, it is most important to use balanced lines there. 
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phantom power
Phantom power is a method to supply condenser microphones with power through microphone cables. Condenser 
microphones give better audio quality than other types of microphones, but they are more sensitive to noise. Preamplifiers 
and mixers can often supply microphones with phantom power. 

gain 
The gain of a preamplifier is the degree to which the amplifier magnifies the low-level input signal compared to its output 
signal. It is the ratio of the output voltage divided by the input voltage and is expressed in decibels (dB). The formula to 
calculate gain is 20 x Log (Voltage output/Voltage input). A gain of 6 dB doubles the voltage 2 times and a gain of 20 dB 
gives a 10 fold increase in the signal.  

gain trim
For some amplifiers the gain can be selected in ranges. For example a LOW gain, gives a range from 18 to 38 dB. With the 
switch Gain trim, you can select the actual gain. 

high pass filter
A high-pass filter (HPF) is a device in a preamplifier that passes high frequencies. Therefore it reduces the amplitude of 
frequencies lower than its cutoff frequency. It is sometimes called a low-cut filter or bass-cut filter.

ceiling microphone
Ceiling microphones are omni directional and are suitable for both speech as other sounds. Media Recorder supports the 
following ceiling microphone:

• Sennheiser MKE2-60-Gold-C (can also be used as table microphone)

The microphone needs 12-48V phantom power.

table microphone
Table microphones are acoustically optimized for picking up speech. They are designed for use on conference tables, altars 
and lecterns. Media Recorder supports the following table microphones: 

• Sennheiser ME35

• Sennheiser ME36

• Sennheiser MKE2-60-Gold-C (can also be used as ceiling microphone)

• Sennheiser e 912 S BK

The microphones need 12-48V phantom power. 

wireless microphone 
Media Recorder supports the Sennheiser EW 312 G3 B series wireless microphone set. Use this wireless microphone set 
when there is more than one test participant, and/or the participants are moving. The microphone set comes with a clip-
on microphone and a receiver. 

The wireless microphone receiver continuously switches between antennas, checks which antenna picks up the strongest 
signal and selects this one. This means that the antennas can be mounted at different places. If for example the reception 
is poor when the wireless microphone is in the experiment room, you could decide to install one antenna in this room. If 
the quality of the received signal is bad, for example if the signal has to go through a wall, you can use the special coax 
cable for extending the antennas (50Ω). In general you want both antennas to use the same cable length. It is 
recommended to position the two antennas at an angle of 90º.

No phantom power is needed for the wireless microphone. The signal that comes from the receiver is preamplified. 

könig cmp-mic9 
The König CMP-MIC9 is a small desk microphone. It is used in the Portable Observation Lab and Portable Usability lab. It 
can be connected directly to the sound card of the computer. Since the signal is not preamplified, choose Mic-in when a 
message pops up that a new devices is detected.  
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audio mixer
With an audio mixer you can adjust the audio streams before they go to Media Recorder. Furthermore, you can combine 
the audio streams from two or more microphones. Media Recorder supports the following audio mixers:

• Extron DMP 64

• Extron DMP 128 
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Appendix J
Picture by Picture resolution

The resolution of the recorded video is maximally 1920 x 1280. The resolution of a Picture by Picture video is a sum of the 
separate videos. However, if that exceeds a width of 1920 pixels or a height of 1280 pixels, the video resolution is adjusted 
proportionally. See the figure below for some examples of calculating the Picture by Picture resolution.

Example 1 — The width of the PbP video is the sum of the width of the separate videos. The height of the PbP video is the 
maximum height of the separate videos. 

Example 2 — The total resolution is calculated in the same way as in Example 1. The width of the resulting video exceeds 
the maximum of 1920 pixels. Therefore both the width and height are reduced proportionally, resulting in a width of 1920 
pixels. 

Example 3 — The total width is the sum of the width Video 1 and 2. The height of is the maximum of the height of Video 1 
and 2 plus the height of Video 3. Both the width and height of the resulting video exceed the maximum of 1920 x 1280. 
Therefore both the width and height are reduced proportionally, resulting in a width of 1920 pixels. The height is now 
smaller than the maximum of 1280 pixels. 

If the height would still have been be higher than 1280, the width and height would be reduced further, resulting in a 
height of 1280 pixels. 

 



Appendix K
Summary supported devices and settings

This table gives an overview of the devices that are supported with Media Recorder. It contains the maximum number of 
devices that can be used simultaneously, the maximum supported frame rate, resolution and recording time, and the 
software in which the videos can be used. 

devices
See  on page 114 for an overview of the supported combinations of devices. 

FaceReader 
Media Recorder videos from all of the devices below can be analyzed by FaceReader, but the files from the 
individual devices have not been tested with this program. 

Device Maximum 
supported 
frame rate 
(fps)

Maximum 
supported 
resolution

Maximum 
number of 
devices

Maximum 
supported 
recording 
time (hrs)

Supported 
on

Desktop 
(D)/ 
Laptop (L)

Supported 
with

Analog 
PAL/CCIR

Euresys 
Picolo U4 
H.264

25 704 x 576 3 24 D EthoVision XT

Analog  
NTSC/EIA

Euresys 
Picolo U4 
H.264

29.97 704 x 480 3 24 D EthoVision XT

Analog 
PAL/CCIR

Euresys 
Picolo U8 
H.264

25 704 x 576 6 

(cables 1,2,3, 
and 5,6,7)

24 D EthoVision XT

Analog 
NTSC/ EIA

Euresys 
Picolo U8 
H.264

29.97 704 x 480 6

(cables 1,2,3, 
and 5,6,7)

24 D EthoVision XT

DanioVision 
FireWire 

60 640 x 480 1 24 D EthoVision XT
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Basler GigE 
AC1300-
60gm

30 853 x 640 4  
Picture by 
picture

24 D EthoVision XT

Basler GigE 
AC1300-
60gm

30 1280 x 960 4  
Separate 
video files

24 D EthoVision XT

Basler GigE 
AC1300-
60gm

30 1280 x 960 1 24 D EthoVision XT

Basler USB 
acA1920-
155um

60 1920 x 1200 1 24 D EthoVision XT

Basler USB 
acA1920-
155um

60 1920 x 1200 1 10 L EthoVision XT

Basler USB 
acA1920-
155um

40 1920 x 1200 4 24 D EthoVision XT

Axis IP P5515 25 1920 x 1080 4 3 D The  
Observer XT

Axis IP 
M1054

25 1280 x 720 8 3 D The  
Observer XT

Axis IP 
M1054

25 1280 x 800 2 1 L The  
Observer XT

Axis IP  
M 5014

25 1280 x 720 1 3 D The  
Observer XT

Axis IP P5534 25 1280 x 720 1 3 D The Observer 
XT

Epiphan 
DVI2PCIe 
screen 
capture card

25 1920 x 1080 1 3 D The  
Observer XT

Device Maximum 
supported 
frame rate 
(fps)

Maximum 
supported 
resolution

Maximum 
number of 
devices

Maximum 
supported 
recording 
time (hrs)

Supported 
on

Desktop 
(D)/ 
Laptop (L)

Supported 
with
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combinations
 The following combinations of devices are supported: 

*Available with MR Screen Capture Module only.

Microsoft 
LifeCam 
Studio

30 1280 x 720 1 1 L The  
Observer XT

Epiphan 
DVI2USB 3.0 
screen 
capture 
device

30 1920 x 1200 1 1 L The  
Observer XT

Device Maximum 
supported 
frame rate 
(fps)

Maximum 
supported 
resolution of 
output file

Maximum 
number of 
devices

Desktop (D)

Laptop (L)

Maximum 
supported 
recording 
time (hrs)

Supported 
with

Axis IP P5515
 

DVI2PCIe

25

25

1920 x 1080

1920 x 1080

3

1

3 The 
Observer XT

Microsoft
LifeCam 
Studio

DVI2USB 3.0

30

30

1280 x 720

1920 x 1200

1

1

L 1 The 
Observer XT

*

Microsoft
LifeCam 
Studio

Built-in 
screen 
capture.

30

30

1280 x 720

1920 x 1080 

1

1

L 1

Device Maximum 
supported 
frame rate 
(fps)

Maximum 
supported 
resolution

Maximum 
number of 
devices

Maximum 
supported 
recording 
time (hrs)

Supported 
on

Desktop 
(D)/ 
Laptop (L)

Supported 
with
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Appendix L
License Agreement

1. LICENSE. Noldus Information Technology b.v. ('Noldus') grants you a non-exclusive license to use the software and 
accompanying documentation (collectively called the 'Software' in this agreement) in accordance with the following 
terms. Noldus retains title and all ownership rights to the Software. Noldus will allow you to make back-up copies of 
the Software, always including copyright notices, provided that these copies are only for your own use. Noldus grants 
you the right to transfer this license and the Software to another party, provided that (a) the other party accepts all 
terms of this agreement, (b) all copies of the software are transferred and you discontinue use of the Software after 
transferring, (c) Noldus is promptly notified of the license number of the Software and the name and address of the 
other party, and (d) Noldus is not required to supply new media. You may not sublicense, assign or transfer the license 
or the Software except as expressly provided in this agreement. Any attempt otherwise to sublicense, assign or 
transfer any of the rights, duties or obligations hereunder is void. You may not receive money or any other form of 
compensation for transferring the license.

2. TERM AND TERMINATION. Failure to comply with any of these terms will terminate this agreement and your right to use 
the Software. You may also choose to terminate the agreement at any time. Upon termination of this agreement, you 
must immediately destroy the Software and all copies of it.

3. LIMITED WARRANTY. Noldus warrants that the media on which the Software is furnished are free of defects in 
workmanship and material under normal use, and that the Software will perform substantially in accordance with the 
specifications set forth in the documentation provided with the Software, for a period of ninety (90) days from the date 
of purchase by you. During the 90-day warranty period, if the Software does not perform as warranted, Noldus at its sole 
option will (a) provide, without charge, a replacement of the media, (b) provide, without charge, corrected Software, (c) 
replace, without charge, Software with a functionally similar program, or (d) refund the fees paid for licensing the 
Software. These are your sole and exclusive remedies for any breach of warranty. Do not return any product until you 
have called Noldus or its supplier and obtained a return authorization number.

4. DISCLAIMER. Software is licensed 'as is' without warranty as to its performance. Except for the limited warranty provided 
above, there are no warranties expressed or implied, including but not limited to implied warranties of merchantability 
or fitness for a particular purpose, and all such warranties are expressly disclaimed. In no event shall Noldus or its 
suppliers be responsible for any indirect or consequential damage or lost profits, even if Noldus and its suppliers had 
been advised of the possibility of such damage.

5. MISCELLANEOUS. The Software and accompanying documentation are protected by both Dutch copyright law and 
international copyright treaty provisions. This agreement will be governed by the laws of The Netherlands.

6. OTHER SOFTWARE. Media Recorder contains:

 MainConcept codecs. Copyright © 2017 MainConcept AG, Aachen.

 MediaLooks DirectShow Filters © 2017 MediaLooks.

 HASP is a trade mark of Gemalto N.V., Amsterdam, The Netherlands (www.gemalto.com).

 LAV audio Filters. 

LAV audio Filters are based on the FFmpeg multimedia libraries (licensed under GPLv2) which is free software: 
you can redistribute it and/or modify it under the terms of the GNU Lesser General Public License as published 
by the Free Software Foundation, either version 3 of the License, or (at your option) any later version. The full 
text of the GNU Lesser General Public License can be found at http://www.gnu.org/licenses/lgpl-3.0.txt . 
Source code is available at http://code.google.com/p/lavfilters/ .

These files or modules may not be reverse assembled, reverse compiled or otherwise translated.

http://www.gnu.org/licenses/lgpl-3.0.txt
http://code.google.com/p/lavfilters/
www.gemalto.com
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